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FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
•
•
•
•

Re orient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:
1.

This device may not cause interference.
And

2.

II

This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1.

This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2.

This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator
and your body.


Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:
1.
2.
3.
4.
5.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.
Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.
Do not use the telephone to report a gas leak in the vicinity of the leak.
Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.
This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter – AC Input 100 240V, 50 - 60Hz, DC Output 19V, 4.74A).

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER,
TELECOMMUNICATION LINE CORD
This Computer’s Optical Device is a Laser Class 1 Product
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Instructions for Care and Operation
The computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:
1.

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

3.

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

4.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost.

5.

Take care when using peripheral devices.
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Power Safety
The computer has specific power requirements:


Power Safety
Warning
Before you undertake
any upgrade procedures, make sure that
you have turned off the
power, and disconnected all peripherals
and cables (including
telephone lines).

VI

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
its wire.
• Make sure the socket and any extension cord(s) you use can support the total current load
of all the connected devices.
• Before cleaning the computer, make sure it is disconnected from any external power supplies.
Do not plug in the power
cord if you are wet.

Do not use the power cord if
it is broken.

Do not place heavy objects
on the power cord.
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Cleaning
Do not apply cleaner directly to the computer, use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:
•
•
•
•
•

When the power cord is damaged or frayed.
If the computer has been exposed to any liquids.
If the computer does not work normally when you follow the operating instructions.
If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Ergonomics
We designed your Multimedia PC system to be functional as well as attractive. To get most out of it, here are
some suggestions on how to position and use the computer:
• The top third of the LCD (screen) should be at eye-level or slightly below.
• The LCD should be at least 18"/45cm. directly in front of you.
• If the screen resolution makes you strain to read, then adjust the resolution to something more comfortable (see “Video
Features” on page 1 - 14).
• Angle the LCD (see “Tilting the LCD Screen” on page 1 - 7) so that it doesn’t reflect any light into your eyes.
• Use a chair which offers good back support (especially lower-back). The seat should allow your feet to rest flat on the
floor or on a footrest directly in front of you.
• If possible, illuminate your work area with natural daylight or use a steady-glowing (non-flickering) light source.
• Place the keyboard and mouse so that your arms are at your sides and your forearms are roughly parallel to the floor.
Your wrists should flex slightly downward as you work. Your neck and shoulders should also be relaxed.
• Take a break from the computer. Get up, stretch, flex your wrists, walk about, and look at something else for about 10
minutes every hour.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.
•
•
•
•

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.
Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:
•
•
•
•

Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.
Turn the monitor off when the system is not in use.


Carrying the Computer
We strongly recommend using both hands to move the computer (one hand gripping the handle area and the other gripping the computer) to avoid accidentally dropping it. Be careful that objects such as belt buckles etc. do not scratch the
screen while it is being carried.

IX

Preface

X

Preface

Contents
Notice .................................................................................I
FCC Statement .............................................................II
FCC RF Radiation Exposure Statement: ................... III
Instructions for Care and Operation ........................... V
Power Safety .............................................................. VI
Cleaning ....................................................................VII
Servicing ...................................................................VII
Ergonomics .................................................................. VIII

Quick Start Guide
Overview ........................................................................1-1
Advanced Users ...........................................................1-2
Beginners and Not-So-Advanced Users ......................1-2
Warning Boxes ............................................................1-2
Not Included ................................................................1-3
System Software ..........................................................1-4
System Startup ...............................................................1-5
System Map: Front View ...............................................1-6
Tilting the LCD Screen ..................................................1-7
Keyboard Options ..........................................................1-8
LED & Hot Key Indicators ............................................1-9
System Map: Left View ...............................................1-10
System Map: Right View .............................................1-11

System Map: Rear View ..............................................1-12
Windows Vista Start Menu & Control Panel ...............1-13
Video Features .............................................................1-14
Display Devices & Options .........................................1-14
Power Options ..............................................................1-16

Features & Components
Overview ........................................................................2-1
Hard Disk Drive .............................................................2-2
Optical (CD/DVD) Device ............................................2-3
Loading Discs ..............................................................2-3
Handling CDs or DVDs ...............................................2-4
DVD Regional Codes ..................................................2-5
7-in-1 Card Reader .........................................................2-6
ExpressCard Slot ............................................................2-7
Inserting and Removing ExpressCards ........................2-7
Audio Features ...............................................................2-8
Audio Jacks ....................................................................2-9
Adding a Printer ...........................................................2-10
USB Printer ..................................................................2-10
Parallel Printer .............................................................2-10

XI

Preface

Power Management
Overview ........................................................................3-1
Turning on the Computer ...............................................3-2
Power Plans ...................................................................3-3
System Power Options ...................................................3-5
Hibernate vs. Shut Down .............................................3-5
Sleep vs. Hibernate ......................................................3-5
Sleep ..............................................................................3-6
Hibernate ........................................................................3-6
Configuring the Power Button .......................................3-7
Resuming Operation ......................................................3-8

Drivers & Utilities
What to Install ................................................................4-1
Module Driver Installation ..........................................4-1
Driver Installation ..........................................................4-2
Updating/Reinstalling Individual Drivers ...................4-4
User Account Control (Win Vista) ..............................4-4
Windows Security Message ........................................4-4
New Hardware Found ..................................................4-4
Driver Installation Procedure ......................................4-5
Chipset ...........................................................................4-5
Video ..............................................................................4-5
Audio .............................................................................4-5
Modem ...........................................................................4-5

XII

LAN ...............................................................................4-5
ExpressCard/Card Reader ..............................................4-6
Hot Key ..........................................................................4-6
e-SATA Support ............................................................4-6
Optional Drivers ..........................................................4-7
Bluetooth Module ..........................................................4-7
Wireless LAN Module ...................................................4-7
PC Camera Module ........................................................4-7
Touch Screen Module ....................................................4-7
Intel Turbo Memory Technology Driver .......................4-7

BIOS Utilities
Overview ........................................................................5-1
The Power-On Self Test (POST) ...................................5-2
Failing the POST .........................................................5-3
Fatal Errors ....................................................................5-3
Non-Fatal Errors ............................................................5-3
The Setup Program ........................................................5-4
Entering Setup .............................................................5-4
Setup Screens ...............................................................5-5
Main Menu .....................................................................5-6
System Time & Date (Main Menu) ...............................5-6
SATA Port 1/2 (Main Menu) .........................................5-7
System/Extended Memory (Main Menu) ......................5-7
BIOS Revision/KBC/EC Firmware

Preface
Revision (Main Menu) ...................................................5-7
Advanced Menu .............................................................5-8
SIO ITE8305E (Advanced Menu) .................................5-8
Installed O/S (Advanced Menu) ....................................5-9
SATA Mode Selection (Advanced Menu) ....................5-9
DFOROM (Robson) Support (Advanced Menu >
SATA Mode Selection [AHCI] ...................................5-10
Reset Configuration Data (Advanced Menu) ..............5-10
Boot-time Diagnostic Screen (Advanced Menu) .........5-10
Legacy OS Boot (Advanced Menu) ............................5-10
Power On Boot Beep (Advanced Menu) .....................5-11
Fan Control (Advanced Menu) ....................................5-11
Security Menu ..............................................................5-12
Set Supervisor Password (Security Menu) ..................5-12
Set User Password (Security Menu) ............................5-13
Fixed disk boot sector (Security Menu) .......................5-13
Password on boot (Security Menu) ..............................5-13
Boot Menu ...................................................................5-14
Exit Menu ....................................................................5-15

Upgrading The Computer
Overview ........................................................................6-1
When Not to Upgrade ..................................................6-2
Removing the Rear Top Cover ......................................6-3
Wireless Keyboard & Mouse USB Receiver .................6-5

Upgrading the Hard Disk Drive .....................................6-6
Upgrading the System Memory (RAM) ........................6-8
Upgrading the Processor ..............................................6-10

Modules & Options
Overview ........................................................................7-1
Bluetooth Module ..........................................................7-2
Bluetooth Configuration in Windows Vista ..................7-3
Wireless LAN Module ...................................................7-6
Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n)
Driver Installation ..........................................................7-7
802.11b/g Driver Installation .........................................7-7
Connecting to a Wireless Network ..............................7-8
Windows Mobility Center .........................................7-11
PC Camera Module ......................................................7-12
PC Camera Driver Installation .....................................7-12
PC Camera Audio Setup ..............................................7-13
Touch Screen Module ..................................................7-19
Touch Screen Utility Installation .................................7-19
Calibrating the Touch Screen ....................................7-20
Tablet PC Input Panel ..................................................7-23
Intel Turbo Memory Module .......................................7-24
Intel Turbo Memory & Matrix Storage Setup and
Driver Installation ........................................................7-24

XIII

Preface

Troubleshooting

USB 2.0/1.1 Ports .........................................................A-5

Overview ........................................................................8-1
Basic Hints and Tips ......................................................8-2
Backup and General Maintenance .................................8-3
Viruses ...........................................................................8-4
Upgrading and Adding New Hardware/Software ..........8-5
Problems & Possible Solutions ......................................8-7

Intel Video Driver Controls

Interface (Ports & Jacks)
Overview ....................................................................... A-1
Computer Ports and Jacks ............................................. A-2
Card Reader Port ........................................................... A-2
COM/Serial Ports .......................................................... A-2
DC-In Jack .................................................................... A-2
e-SATA Port ................................................................. A-2
External Monitor (VGA) Port ....................................... A-3
HDMI-Out Port ............................................................. A-3
Headphone-Out Jack ..................................................... A-3
Line-In Jack .................................................................. A-3
Microphone-In Jack ...................................................... A-3
Mini-IEEE 1394 Port .................................................... A-4
RJ-11 Phone Jack .......................................................... A-4
RJ-45 LAN Jack ........................................................... A-4
Security Lock Slot ........................................................ A-4
S/PDIF-Out Jack ........................................................... A-4

XIV

Video ............................................................................. B-1
Dynamic Video Memory Technology ........................ B-1
Scheme Options ........................................................B-4
Configuring Other Displays from Intel® GMA
Driver for Mobile .......................................................... B-6
To Enable Intel(R) Dual Display Clone ..................... B-10
To Enable Extended Desktop ..................................... B-11
Using Display Settings to Enable Extended Mode ..... B-13

Specifications
Processor ....................................................................... C-2
Core Logic .................................................................... C-2
LCD .............................................................................. C-2
Memory ......................................................................... C-2
Video Adapter ............................................................... C-3
BIOS ............................................................................. C-3
Storage .......................................................................... C-3
Audio ............................................................................ C-3
Security ......................................................................... C-3
Keyboard ....................................................................... C-3
Interface ........................................................................ C-3
Card Reader .................................................................. C-4

Preface
ExpressCard Slot .......................................................... C-4
Mini-Card Slots ............................................................ C-4
Communication ............................................................. C-4
Power Management ...................................................... C-4
Power ............................................................................ C-4
Environmental Spec ...................................................... C-4
Dimensions & Weight .................................................. C-5
Optional ........................................................................ C-5

Windows XP Information
DVD Regional Codes ................................................... D-2
Windows XP Start Menu & Control Panel ................... D-3
Audio Features .............................................................. D-4
Audio Jacks ...................................................................D-5
Video Features .............................................................. D-6
Dynamic Video Memory Technology ..........................D-6
Display & Graphics Properties .....................................D-7
Display Devices & Options ........................................... D-9
Attaching Other Displays ........................................... D-10
HDMI Audio Configuration ........................................ D-14
Power Management .................................................... D-16
Power Schemes............................................................ D-17
System Power Options................................................. D-18
Hibernate Mode vs. Shutdown ...................................D-18
Configuring the Power Button..................................... D-20

Driver Installation ....................................................... D-21
Updating/Reinstalling Individual Drivers....................D-22
Driver Installation Procedure....................................... D-23
Chipset ........................................................................D-23
Video ...........................................................................D-23
Audio ..........................................................................D-23
Modem ........................................................................D-24
LAN ............................................................................D-24
CardReader .................................................................D-24
Hot Key .......................................................................D-24
Optional Drivers .......................................................... D-25
Bluetooth Module .......................................................D-25
Wireless LAN Module ................................................D-25
PC Camera Module .....................................................D-25
Touch Screen Module .................................................D-25
Bluetooth Module ....................................................... D-26
Bluetooth Configuration in Windows XP ...................D-28
To Add a Bluetooth Device ........................................D-29
Wireless LAN Module ................................................D-31
Intel WLAN Driver Installation ..................................D-32
802.11b/g WLAN Driver Installation .........................D-34
PC Camera Module ..................................................... D-35
PC Camera Driver Installation ....................................D-35
Touch Screen Module ................................................. D-41
Touch Screen Utility Installation ................................D-41

XV

Preface
Calibrating the Touch Screen ...................................... D-42

XVI

Quick Start Guide

Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:
• Chapter 2
• Chapter 3
• Chapter 4
• Chapter 5
• Chapter 6
• Chapter 7

• Chapter 8
• Appendix A
• Appendix B
• Appendix C
• Appendix D

A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, 7-in-1 card reader, ExpressCard/34/54) Audio & Printer.
The computer’s power saving options.
The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.
An outline of the computer’s built-in software or BIOS (Basic Input Output System).
Instructions for upgrading your computer.
A quick guide to the computer’s Bluetooth, Wireless LAN, PC Camera, Touch Screen and
Turbo Memory modules (some of which may be optional depending on your purchase configuration).
A troubleshooting guide.
Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.
Information on the Intel video driver controls.
The computer’s specification.
Information on the Windows XP OS.
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.


Notes
Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1 - 2 Overview

Quick Start Guide

Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.


Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already
done that for you), refer to “What to Install” on page 4 - 1 for installation instructions.

Ports and Jacks
See “Computer Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are supported.
Operating System & Version Supported

Note

*Windows XP - SP2 (Home or Professional)
Windows Vista - SP1 (64-bit) Home Basic Edition
Windows Vista - SP1 (64-bit) Home Premium Edition
Windows Vista - SP1 (64-bit) Business/Enterprise/Ultimate Editions

In order to run Windows Vista without limitations
or decreased performance, your computer
requires a minimum 1GB of system memory
(RAM).

Table 1 - 1 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Windows XP Information” on page D - 1.


Windows Vista Service Pack 1
Make sure you install Windows Vista Service Pack 1 (or a Windows Vista version which includes Service Pack 1) before installing any drivers. Go to the Microsoft website for download details, or contact your service center.
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System Startup
1.
2.
3.
4.

Remove all packing materials, CDs/DVDs and floppy disks etc.
Securely attach any peripherals you want to use with the computer to their ports (e.g keyboard and mouse etc.)
Attach the AC/DC adapter to the DC-In jack located under the LCD, then plug the AC power cord into an outlet,
and connect the AC power cord to the AC/DC adapter.
Push the power button at the front of the computer (under the LCD) to turn the computer “on”.

Power Button (located under the LCD)


Shutdown
Note that you should always shut your computer down by choosing the Shut Down command from the Lock Button Menu
in Windows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - AC/DC Adapter Plugged-In/Power Button
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System Map: Front View
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.

Optional Built-In PC Camera
LCD (With Optional Touch Panel)
Power & System Activity LED Indicators
Volume Buttons (under the LCD)
Brightness Buttons (under the LCD)
Power Button (under the LCD)
USB Ports
Microphone-In Jack
Headphone/Speaker-Out Jack
DC-In Jack (under the LCD)
2 * COM Ports (under the LCD)
External Monitor Port (under the LCD)
eSATA Port (under the LCD)
2 * USB Ports (under the LCD)
RJ-11 Phone Jack (under the LCD)
RJ-45 LAN Jack (under the LCD)

1

2

3

4

7
4
8

9

10

Figure 1 - 2 - Front View

1 - 6 System Map: Front View

6

8 9

6

5

3
7

5

11

12

13

14 15 16

Quick Start Guide

Tilting the LCD Screen
It is possible to tilt the LCD screen in order to get the best possible viewing angle of the screen without glare etc.
Apply pressure with one hand at the base of the computer, while carefully pushing the LCD screen to tilt it to
the appropriate viewing angle.


45°

Moving the Computer
We strongly recommend using both hands to
move the computer. You can use one hand to
grip the computer by the stand, and the other to
hold the top of the LCD screen.

-5°

It is recommended that you carry the computer
with the LCD facing your body to avoid scratching
the surface against other objects. However take
care not to scratch the LCD with any personal
items, belt fittings or jewelry etc.(one hand gripping the stand and the other gripping the top of
the computer to avoid accidentally dropping it).

Figure 1 - 3 - LCD Screen Tilt

Tilting the LCD Screen 1 - 7

1

1

Quick Start Guide

Keyboard Options
There are two keyboard options for this computer series. These keyboards may include embedded numerical
keypads for easy numeric data input and/or function keys/hot keys to allow you to change operational features
instantly. Some keyboards may require a driver to access all available functions etc.

Figure 1 - 4 - Optional Wireless Keyboard & Mouse Kit

A USB port located behind the rear top cover is designed to house the receiver for the USB wireless Keyboard
& Mouse Kit (or a USB transceiver for any Keyboard/Mouse). See “Wireless Keyboard & Mouse USB Receiver” on page 6 - 5 for more information.
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LED & Hot Key Indicators
The LED indicators on the computer display helpful
information about the current status of the computer.
Icon

Color

Description

Green

The computer is On

Blinking Green

The computer is in Sleep Mode

Orange

The AC/DC Adapter is Plugged
in & the Computer is Powered
Off

Green

System Activity

Table 1 - 2 - LED Indicators

Visual indicators for brightness and volume are available when the hot key utility is installed (see “Hot
Key” on page 4 - 6). When the driver is installed, an
icon will appear in the taskbar.
Note that these indicators illustrate the volume and
brightness level changes when adjusted by the brightness and volume buttons on the computer itself (some
keyboards may provide their own indicators).
Hot Key Icon

Description
Volume Decrease/Increase

Brightness Decrease/Increase

Table 1 - 3 - Hot Key Indicators

LED & Hot Key Indicators 1 - 9
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Figure 1 - 5
Left View
Stand
S/PDIF-Out Jack
Headphone-Out
Jack
4. Microphone-In Jack
5. Line-In Jack
6. Mini-IEEE 1394
Port
7. HDMI-Out Port
8. 1 * USB 2.0 Port
9. 7-in-1 Card Reader
10. ExpressCard Slot
(see page 2 - 7)

System Map: Left View


1.
2.
3.

ExpressCard Slot

10

The ExpressCard Slot accepts either
ExpressCard/34 or ExpressCard/
54 formats.

9

7-in-1 Card Reader
The card reader allows you to use
the most popular digital storage card
formats:
MMC (MultiMedia Card) / SD (Secure
Digital) / MS (Memory Stick) / MS Pro
(Memory Stick Pro) / MS Duo (requires
PC adapter) /
Mini SD (requires PC adapter) / RS MMC
(requires PC adapter)

8
7
6
1

5
4

Mini-IEEE 1394 Port
The Mini-IEEE 1394 port only supports SELF POWERED IEEE 1394
devices.

1 - 10 System Map: Left View

3
2

Quick Start Guide

System Map: Right View
Figure 1 - 6 - Right View
1.
2.



Stand
Optical Device Drive Bay (for CD/DVD Device - see
page 2 - 3)

CD Emergency Eject
If you need to manually
eject a CD/DVD (e.g. due
to an unexpected power
interruption) you may
push the end of a straightened paper clip into the
emergency eject hole. Do
not use a sharpened pencil or similar object that
may break and become
lodged in the hole.


Changing DVD Regional Codes
Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).
DVD region detection is device dependent, not OSdependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

2

Media Warning

1

Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it.
This may cause the system to “crash”.

System Map: Right View 1 - 11

1

1

Quick Start Guide
Figure 1 - 7
Rear View
1.
2.
3.
4.
5.

Stand
Rear Component
Cover
Vent/Fan Intake
Security Lock Slot
Carrying Handle
Area

System Map: Rear View
3


CPU

2

The CPU is not a user serviceable
part. Opening this compartment, or
accessing the CPU in any way,
may violate your warranty.

1

Overheating
To prevent your computer from
overheating make sure nothing
blocks the Vent/Fan Intake while
the computer is in use.

3

3

4
5


Carrying the Computer
We strongly recommend using both hands to move the computer (one hand gripping the
handle area and the other gripping the computer) to avoid accidentally dropping it. Be
careful that objects such as belt buckles etc. do not scratch the screen while it is being
carried.

1 - 12 System Map: Rear View
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

Click here to toggle Classic View
Figure 1 - 8 - Start Menu & Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Windows Vista Start Menu & Control Panel 1 - 13
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Video Features
You can switch display devices, and configure display options, from the Display Settings control panel (in Personalization) in Windows Vista as long as the appropriate Intel video driver is installed. For more detailed video information see “Intel Video Driver Controls” on page B - 1.
To access Display Settings in Windows Vista:
1.
2.
3.
4.
5.
6.

7.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Adjust screen resolution under the Appearance and Personalization menu (or double-click
Personalization > Display Settings).
Move the slider to the preferred setting in Resolution: 1 (Figure 1 - 9 on page 1 - 15).
Click the arrow, and scroll to the preferred setting In Colors: 2 (Figure 1 - 9 on page 1 - 15).
Click Advanced Settings (button) 3 (Figure 1 - 9 on page 1 - 15) and click Intel(R) GMA Driver for mobile
(tab).
Click Graphics Properties (button) 4 (Figure 1 - 9 on page 1 - 15) to access the Intel GMA control panel
(this control panel can also be accessed by double-clicking Intel(R) GMA Driver for mobile in the Windows
control panel if Classic View is selected - see Figure 1 - 8 on page 1 - 13).
The Intel GMA control panel can also be accessed by clicking the icon
in the taskbar and selecting
Graphics Properties from the menu.

Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display
connected to the external monitor port as your display device.

1 - 14 Video Features
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1

2

4

3
Figure 1 - 9 - Display Properties Desktop

Intel Display Mode

Description

Single Mode

One of the connected displays is used as the display device

Intel(R) Dual Display Clone Mode

Both connected displays output the same view and may be configured independently

Extended Desktop Mode

Both connected displays are treated as separate devices, and act as a virtual desktop

Table 1 - 4 - Display Options
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 13) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, display and sleep mode from the left menu. Note
that the power saver plan may have an affect on computer performance.
Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further configuration options.

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 10 - Power Options
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Chapter 2: Features & Components

2

Overview
Read this chapter to learn more about the following main features and components
of the computer:
•
•
•
•
•
•

Hard Disk Drive
Optical (CD/DVD) Device
7-in-1 Card Reader
ExpressCard Slot
Audio Features
Adding a Printer

Overview 2 - 1
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Power Safety
Before attempting to access any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the machine is turned off. Also
ensure that all peripheral cables, including
phone lines, are disconnected from the computer.

Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height
of 9.5 mm.
The hard disk is accessible from the rear of your computer as seen below. For further
details see “Upgrading the Hard Disk Drive” on page 6 - 6.

Figure 2 - 1
Hard Disk Location

2 - 2 Hard Disk Drive

Hard Disk
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 14).

Loading Discs
To insert a CD/DVD, press the open button 1 and carefully place a CD/
DVD onto the disc tray with label-side facing up (use just enough force
for the disc to click onto the tray’s spindle). Gently push the CD/DVD
tray in until its lock “clicks” and you are ready to start. The busy indicator
2 will light up while data is being accessed, or while an audio/video CD,
or DVD, is playing. If power is unexpectedly interrupted, insert an object
such as a straightened paper clip into the emergency eject hole 3 to open
the tray.

3


Sound Volume
Adjustment
How high the sound volume can be set depends
on the setting of the volume control within Windows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 8).

1
2

Figure 2 - 2
Optical Device

Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs


CD Emergency Eject
If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharpened pencil or similar
object that may break
and become lodged in
the hole.

Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.
Note the following:
•
•
•
•
•
•
•
•

Hold the CD or DVD by the edges; do not touch the surface of the disc.
Use a clean, soft, dry cloth to remove dust or fingerprints.
Do not write on the surface with a pen.
Do not attach paper or other materials to the surface of the disc.
Do not store or place the CD or DVD in high-temperature areas.
Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
Do not bend the CD or DVD.
Do not drop or subject the CD or DVD to shock.

Disk Eject Warning
Don’t try to remove a
CD/DVD while the system is accessing it. This
may cause the system
to “crash”.
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DVD Regional Codes

2

To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 11.
DVD Regional Coding
Region

Geographical Location

1

USA, Canada

2

Western Europe, Japan, South
Africa, Middle East & Egypt

3

South-East Asia, Taiwan, South
Korea, The Philippines, Indonesia,
Hong Kong

4

South & Central America, Mexico,
Australia, New Zealand

5

N Korea, Russia, Eastern Europe,
India & Most of Africa

6

China

Table 2 - 1
DVD Regional
Coding

Optical (CD/DVD) Device 2 - 5
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Card Reader Cover
Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust getting in to the card reader.

Figure 2 - 3
Front View
1.

7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “ExpressCard/Card Reader” on page 4 - 6).
•
•
•
•
•
•
•

Card Reader

2 - 6 7-in-1 Card Reader

MMC (MultiMedia Card)
SD (Secure Digital)
MS (Memory Stick)
MS (Memory Stick Pro)
MS Duo (requires PC adapter)
Mini SD (requires PC adapter)
RS MMC (requires PC adapter)

1
1
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ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).
ExpressCard/54 is used for applications which
require a larger interface slot, e.g. CompactFlash card reader. The number denotes the card
width; 54mm for the Express Card/54 and
34mm for the ExpressCard/34. Make sure you
install the Card Reader driver (see “ExpressCard/Card Reader” on page 4 - 6).

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and
push it in until it locks into place.
• To remove an ExpressCard, simply press
the card to eject it.

ExpressCard Slot
Cover
Make sure you keep the
cover in the ExpressCard slot when not in
use. This will help prevent foreign objects and/
or dust getting in to the
ExpressCard Slot.

3
1



1
2
1

Figure 2 - 4
ExpressCard Slot
1.

ExpressCard
Slot

ExpressCard Slot 2 - 7
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Sound Volume
Adjustment
The sound volume level
is set using the volume
control within Windows
(and the volume function keys on the computer). Click the volume
icon in the taskbar to
check the setting.

Audio Features
You can configure the audio options on your computer from the Sound control
panel in Windows, or from the Realtek HD Audio Manager icon in the taskbar/
control panel (right-click the taskbar icon
to bring up an audio menu). You can
adjust the volume by means of the volume buttons on the computer.

Right-click the icon
to access the menu
above.

Figure 2 - 5
Realtek Audio
Manager

2 - 8 Audio Features
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Audio Jacks

2

Note that the system has two sets of audio jacks as well as internal speakers. All the
audio jacks cannot function at the same time and are therefore assigned a priority
order depending on your audio connections.
• Priority 1 = The audio jacks at the front of the computer. Thus the audio
jacks at the side of the computer and the internal speakers are disabled (e.g if
you connect headphones to the headphone-out jack at the front of the computer
then speakers/headphones connected to the headphone-out jack at the side of the
computer are disabled).
• Priority 2 = The audio jacks at the side of the computer. Thus the internal
speakers are disabled (e.g if you connect speakers to the headphone-out jack at
the side of the computer then the internal speakers are disabled).
• Priority 3 = The internal speakers. If there are no audio connections to any of
the audio jacks, then the audio output will default to the internal speakers.

Audio Features 2 - 9
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Parallel Printer
After setting up the printer attach the parallel cable to the printer.
Connect the printer’s
parallel cable to the Parallel to USB converter,
and then plug the converter into the USB port.
Turn ON the printer,
then turn ON the computer.
Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen instructions.

Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer, however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.
Install Instructions:
1.
2.
3.
4.
5.

Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
Turn ON the computer.
Turn ON the printer.
Connect the printer’s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

2 - 10 Adding a Printer
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power management conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system.
This chapter covers:
•
•
•
•

Turning on the Computer
Power Plans
System Power Options
Configuring the Power Button

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user settings and information from applications.
Using some form of power management greatly increases the life span of the
LCD.


OS Note
Power
management
functions will vary slightly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operating system.
(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)

Hibernate Mode In
Windows Vista SP1
If you are using Windows Vista SP1 with
4GB RAM installed, see
page 8 - 9 for information on Hibernate.

Overview 3 - 1
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Shut Down
Note that you should always shut your computer down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vista. This will help prevent
hard disk or system
problems.

Turning on the Computer
To turn the computer on simply press the power button (see “System Startup” on
page 1 - 5).
When the computer is on, you can use the power button as a Sleep/Hibernate hotkey button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down). Use Power Options (Hardware and Sound menu) control panel in Windows Vista to configure
this feature.


Forced Off
If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep
Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Button” on page 3 - 7 for details).

3 - 2 Turning on the Computer
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.
The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.
Click Change plan settings and then click Change advanced power settings to access further configuration options in Advanced Settings.


Resuming
Operation
See Table 3 - 1, on
page 3 - 8 for information on how to resume
from a power-saving
state.

Password
It is recommended that
you enable a password
on system resume in order to protect your data.

Figure 3 - 1
Power Plan
Advanced Settings

Power Plans 3 - 3
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Power Management
Each Windows power plan will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance.

3

Figure 3 - 2
Power Plans

3 - 4 Power Plans
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System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. The system features Sleep and Hibernate power saving states.

Hibernate vs. Shut Down
Hibernate and Shut Down are the same in that the system is off and you need to press
the power button to turn it on. Their main difference is:
When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.
You can use either method depending on your needs.


Sleep Button
The Power Button
in the Start Menu (in
Classic View use the
Shut Down button
)
can be used to send the
computer into a powersaving state.
Note that Sleep is the
default power saving
state in Windows Vista.

Sleep vs. Hibernate
If you want to stay away from your work for just a while, you can put the system into
Sleep instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Sleep mode.

System Power Options 3 - 5
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Sleep
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Hibernate Mode In
Windows Vista SP1
If you are using Windows Vista SP1 with
4GB RAM installed, see
page 8 - 9 for information on Hibernate.

Sleep uses very little system power, and takes a short time to return to full operation.
After an extended period of time in Sleep the computer will save the contents of system memory (e.g. any open documents and applications) to the hard disk and shut
the system down. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the hard disk
before it turns the system off. Although it saves the most power it takes the longest
time to return to full operation. You will need to enable Hibernate mode from the
Advanced Settings in power plans, or you put the system directly into Hibernate
mode from the Lock Button Menu. The system will resume from Hibernate
mode by pressing the power button.

Figure 3 - 3
Lock Button Menu

3 - 6 System Power Options
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Configuring the Power Button
The power button may be set to send the computer in to either Sleep or Hibernate.
In Sleep, the LED will blink green. In Hibernate the LED will be orange. If only
the display is turned off, the LED will remain green.


Password
Protection
It is recommended that
you enable a password
on wake up in order to
protect your data.
However you can disable this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and selecting the options (click
Change settings that
are currently unavailable).

Figure 3 - 4
Power Options
Define Power
Buttons

Configuring the Power Button 3 - 7
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (see your keyboard documentation).

3

Power Status

Icon

To Resume

Color

Power Off

Off

Press the Power Button

Sleep

Blinking Green

Press the Power Button
Press the Sleep Button (on your keyboard)

Table 3 - 1

Hibernate

Resuming
Operation

Orange (AC/DC adapter)

Press the Power Button


Power Button
When the computer is on, you can use the power button as a Sleep/Hibernate hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for
longer than this will force shut the computer to shut down).

3 - 8 Configuring the Power Button
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or improvement of some
of the computer’s subsystems. The system takes advantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.
Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are installed in the order indicated (see “Driver Installation” on page D - 21 for Windows XP driver
information).

Module Driver Installation
The procedures for installing drivers for the Wireless
LAN, PC Camera, Touchscreen Utility and Intel
Turbo Memory (and Intel Matrix Storage) are provided in “Modules & Options” on page 7 - 1. Make
sure that the drivers are installed in the order indicated
in Table 4 - 1, on page 4 - 3. Only install drivers for
modules included in your purchase option.

What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button)/Option Drivers
(button).

1.

2.

4
3.

Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
this order) which is the same as that listed in the
Drivers Installer menu below.
Click to select the driver you wish to install, after
installing each driver it will become grayed out (if
you need to reinstall any driver, click the Unlock
button).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation

Drivers & Utilities
Driver - Windows Vista with Service Pack 1

Page #

Chipset

Page 4 - 5

Video

Page 4 - 5

Audio

Page 4 - 5

Modem

Page 4 - 5

LAN

Page 4 - 5

ExpressCard/Card Reader

Page 4 - 6

Hot Key

Page 4 - 6

e-SATA Support

Page 7 - 24

Wireless LAN Module

Page 7 - 6

PC Camera Module

Page 7 - 12

Touch Screen Module

Page 4 - 7

Intel Turbo Memory Module

Page 7 - 24

Manual Driver Installation
Click Browse CD (button) in the Drivers Installer application and browse to the executable file in the appropriate driver folder.
Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 6 for instructions.


Windows Vista Service Pack 1
Make sure you install Windows Vista Service Pack 1
(or a Windows Vista version which includes Service
Pack 1) before installing any drivers. Go to the Microsoft website for download details, or contact your service
center.

Table 4 - 1 - Driver Installation

Driver Installation 4 - 3

4

Drivers & Utilities

4

Updating/Reinstalling Individual Drivers

User Account Control (Win Vista)

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Programs > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be necessary to restart the computer). Reinstall the driver as
outlined in this chapter.

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as directed.

If the driver is not listed in the Programs and Features menu:
1.
2.
3.

4.

Click Start, and click Control Panel (or point to
Settings and click Control Panel).
Double-click Device Manager (Hardware and
Sound > Device Manager).
Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).
Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

4 - 4 Driver Installation

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the installation procedure.
You will receive this message in cases where the driver has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” during the installation procedure (other than when outlined in the driver install procedure), click Cancel
to close the window, and follow the installation procedure.

Drivers & Utilities

Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.
Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.
Audio
1. Click 3.Install Audio Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.


Modem Country Selection
Go to the Phone and Modem Options control panel (Hardware and Sound) and make sure the modem country selection
is appropriate for you.

LAN
1. Click 5.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.
4. The network settings can now be configured.

Driver Installation 4 - 5
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ExpressCard/Card Reader
1. Click 6.Install CardReader Driver > Yes.
2. Click Next > Install.
3. Click Finish to complete the installation.

4

Hot Key
1. Click 7.Install Hotkey Driver > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart your computer.
e-SATA Support
See “Intel Turbo Memory & Matrix Storage Setup
and Driver Installation” on page 7 - 28 for instructions on installing this driver to enable the e-SATA
port.


Windows Update
After installing all the drivers make sure you enable Windows Update in order to get all the latest security updates etc. (all updates will include the latest hotfixes
from Microsoft).
To enable Windows Update make sure you are connected to the internet:

1.
2.

3.
4.
5.

4 - 6 Driver Installation

Click Start, and click Control Panel (or point
to Settings and click Control Panel).
Click Check for updates (Security), or
double-click Security Center and click
Windows Update.
Double-click Check for updates (button).
The computer will now check for updates
(you need to be connected to the internet).
Click Install now (button) to install the
updates.

Drivers & Utilities

Optional Drivers

Bluetooth Module

See the pages indicated for the driver installation procedures for any modules included in your purchase option. Insert the Device Drivers & Utilities + User’s
Manual disc and click Option Drivers (button) to access the optional driver menu.

Note: The operating system is the default setting for
Bluetooth control in Windows Vista. See “Bluetooth
Module” on page 7 - 2 for configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 6, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on
page 7 - 12, and check the installation procedure.

Touch Screen Module
See the introduction in “Touch Screen Module” on
page 7 - 19, and check the installation procedure.

Intel Turbo Memory Technology Driver
Figure 4 - 3 - Optional Drivers

See the introduction in “Intel Turbo Memory Module” on page 7 - 28, and check the installation procedure. Note this driver is also required to enable
support for the e-SATA port.
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software:
Diagnostics: The POST (Power-On Self Test)
Configuration: The Setup utility
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your
system ever needs servicing.


BIOS Settings
Warning
Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Setup and restore the Setup Defaults with <F9>.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

5

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup.
If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.
The screen which appears at startup depends on whether or not you have enabled/
disabled the Boot-time Diagnostic Screen (see “Boot-time Diagnostic Screen (Advanced Menu)” on page 5 - 10).
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “nonfatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:
• Press <F1> to resume
• <F2> to enter Setup
Press F1 to see if the boot process can continue. It may work, without the correct
configuration.
Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

The Power-On Self Test (POST) 5 - 3
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The Setup Program
The Setup Utility program tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup

5

To enter the Setup Utility, turn on the computer and press F2 during the POST. The
prompt (Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because
you pressed F2 too quickly) just press F2 again.
If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup Utility main menu will appear.

5 - 4 The Setup Program

BIOS Utilities

Setup Screens
The following pages contain additional advice on portions of the Setup Utility.


Setup Menus

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup Utility.
Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The
Setup
menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configuration appropriate for your
model and options.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.
If you see an arrow next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

The Setup Program 5 - 5
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Main Menu
Phoenix SecureCore(tm) Setup Utility

Figure 5 - 1

Main
Main

Advanced

Security

Boot

Exit

Main Menu

Item Specific Help
[22:12:05]
[05/28/2008]

System Time:
System Date:
 SATA Port 1
 SATA Port 2

5

[None]
[None]

System Memory:
Extended Memory:

640 KB
1979 MB

BIOS Revision:
KBC/EC Firmware Revision:

******
******

F1
Esc

Help
Exit




Select Item
Select Menu

-/+
Enter

<Tab>, <Shift Tab>, or
<Enter> selects field.

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

5 - 6 Main Menu
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SATA Port 1/2 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a hard disk or optical device drive on the computer’s SATA Ports. Use the Auto (Type:) setting to
have the items configured automatically for you.
System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

5

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the BIOS version etc. and is not user configurable.

Main Menu 5 - 7

BIOS Utilities

Advanced Menu
Phoenix SecureCore(tm) Setup Utility

Figure 5 - 2

Main

Advanced
Advanced

Security

Boot

Exit

Advanced Menu

Item Specific Help
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SIO ITE8305E
Installed O/S:
SATA Mode Selection:
DFOROM(Robson) Support:
Reset Configuration Data:
Boot-time Diagnostic Screen:
Legacy OS Boot:
Power On Boot Beep:
FAN Control:

[Vista]
[AHCI]
[Enabled]
[No]
[Disabled]
[Disabled]
[Enabled]
[Disabled]

These items control
the configuration of
various National 393
SIO devices.

Only available if Windows Vista

is selected as the O/S.

F1
Esc

Help
Exit




Select Item
Select Menu

-/+
Enter

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

SIO ITE8305E (Advanced Menu)
The sub-menu here allows you to adjust settings for the computer’s serial ports.
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Installed O/S (Advanced Menu)
This setting tells the computer what kind of operating system you’re using. Make
sure you choose the correct setting for your O/S in order to prevent system problems.
Note: If you select the Vista O/S then the SATA Mode Selection menu will become
available. If you are installing the Windows XP O/S make sure you have set the appropriate operating system here in order to prevent system problems.
SATA Mode Selection (Advanced Menu)
This menu is only available if you select the Vista O/S as your operating system.
You can configure SATA (Serial ATA) control to operate in either IDE (native/
compatible) or AHCI (Advanced Host Controller Interface) modes from this menu.
The SATA mode should be set to AHCI mode for this system (unless you are sure
your hard disk can only operate in IDE mode). If you are unsure of the mode your
hard disk supports contact your service center. Note the following:


SATA Mode
Selection
If you have installed the
Windows Vista operating system with AHCI
mode enabled (default
setting), DO NOT disable AHCI mode (if you
wish to disable AHCI
mode you will need to
reinstall the Windows
VIsta OS).

• If you have installed the Windows Vista O/S with AHCI enabled, DO NOT disable it (see sidebar).
• The SATA mode should be set to AHCI if you have included an Intel Turbo
Memory (Robson) NAND flash memory card module in your purchase option.
You can then enable the option from the DFOROM (Robson) Support Menu.
• The SATA mode should be set to AHCI, and the DFOROM (Robson) Support
Menu setting should be set to “Enabled” to support eSATA port hot-swapping.

Advanced Menu 5 - 9
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SATA Mode & eSata
Port

5

The eSATA port only
supports hot-swapping
if you have selected
AHCI mode in SATA
Mode Selection, and
enabled
DFOROM
(Robson) Support.

DFOROM (Robson) Support (Advanced Menu > SATA Mode Selection [AHCI]
This item will only be available if you have selected AHCI in SATA Mode Selection. The option should be enabled if you have included an optional Intel Turbo
Memory Module in your purchase configuration, or you want to support eSATA
port hot-swapping. You should then install the driver as per the instructions in “Intel
Turbo Memory & Matrix Storage Setup and Driver Installation” on page 7 - 24.
Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.
Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen (or POST)
screen.
Legacy OS Boot (Advanced Menu)
Enable this item to support only system boot from the Legacy OS (e.g Windows Vista). If disabled the system will attempt to boot from the EFI (Extensible Firmware
Interface) before the Legacy OS.

5 - 10 Advanced Menu

BIOS Utilities
Power On Boot Beep (Advanced Menu)
Use this menu to enable/disable the single beep sound at the end of the POST. This
item is “Disabled” by default.
Fan Control (Advanced Menu)
This menu item allows you to set the fan cooling behavior under light system activity
(if you choose Automatic the system will adjust the fan cooling as appropriate for
the system activity).
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Security Menu
Phoenix SecureCore(tm) Setup Utility

Security Menu

Main

Advanced

Security
Security

Boot

Exit

=

5

Item Specific Help

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your machine as it boots up after you turn it on.
These settings do not
affect your machine or
network
passwords
which will be set in
your software OS.
F1
Esc

Figure 5 - 3
Security Menu
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Supervisor Password Is:
User Password Is:

Clear
Clear

Set Supervisor Password
Set User Password

[Enter]
[Enter]

Fixed disk boot sector:
Password on boot:

[Normal]
[Disabled]

Help
Exit




Select Item
Select Menu

-/+
Enter

Supervisor Password
controls access to the
setup utility.

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup Utility. This will not affect access to
the computer OS (only the Setup Utility).

BIOS Utilities
Set User Password (Security Menu)
You can set a password for user mode access to the Setup Utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a
Password on Boot (see below). Many menu items in the Setup Utility cannot be
modified in user mode. You can only set the user password after you have set the
supervisor password.
Fixed disk boot sector (Security Menu)
If you choose “Write-Protect” this will protect against viruses being written to the
hard disk boot sector (this is not a substitute for installing an anti-virus program - see
“Viruses” on page 8 - 4).
Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”.


Password Warning
If you set a boot password (Password on boot
is “Enabled“), NEVER
forget your password.
The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your vendor and you may lose all
of the information on
your hard disk.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Security Menu 5 - 13
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Boot Menu
Figure 5 - 4

Phoenix SecureCore(tm) Setup Utility
Main

Advanced

Security

Boot

Exit

Boot Menu

Item Specific Help
Boot priority order:
1: USB KEY:
2: USB HDD:
3: IDE CD:
4: IDE HDD:
5: PCI BEV: P4-Optiarc CDRWDVD CRX890S
6: USB FDC:
7: USB CDROM:
8:
Excluded from boot order:
: USB ZIP:
: USB LS120:
: PCI SCSI: P0-FUJITSU MHY2120BH
: PCI BEV: Realtek Boot Agent
: Other USB:
: PCI:
: Legacy

5



F1
Esc

Help
Exit




Select Item
Select Menu

-/+
Enter

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<f> and <r> specifies
the device fixed or
removable.
<x> exclude or include
the device to boot.
<Shift + 1> enables or
disables a device.
<1 - 4> loads default
boot sequence.

Change Values
Select Sub-Menu

F9 Setup Defaults
F10 Save and Exit

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.
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Exit Menu
Figure 5 - 5

Phoenix SecureCore(tm) Setup Utility
Main

Advanced

Security

Boot

Exit

Exit Menu
Item Specific Help

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes

F1
Esc

Help
Exit




Select Item
Select Menu

Exit System Setup and
save your changes to
CMOS.

-/+
Enter

Change Values
Select Sub-Menu
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F9 Setup Defaults
F10 Save and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Setup defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:
• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap


Warranty Warning
Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the components.
The chapter includes:
•
•
•
•

Removing the Rear Top Cover
Wireless Keyboard & Mouse USB Receiver
Upgrading the Hard Disk Drive
Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Overview 6 - 1
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When Not to Upgrade


Power Safety
Warning

6

Before you undertake
any upgrade procedures, make sure that
you have turned off the
power, and disconnected all peripherals and
cables (including telephone lines).

These procedures involve opening the system’s case, adding and sometimes replacing parts.
You should not perform any of these upgrades if:
•
•
•
•

Your system is still under warranty or a service contract
You don’t have all the necessary equipment
You’re not in the correct environment
You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).


Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
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Removing the Rear Top Cover
Before undertaking any upgrade procedure it is necessary to remove the rear top
cover to access the components.
1.
2.
3.

Turn off the computer and disconnect all cables and peripherals.
Carefully place the computer flat with the LCD facing down (make sure you cover
the LCD to avoid scratches) so that you may access the rear cover.
Remove screws 1 - 4 .

6
1

2

3

4

Figure 6 - 1
Rear Top Cover
Screws
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4.

Slide the rear top cover until the arrow is aligned with the unlock icon 5 .

Figure 6 - 2
Rear Top Cover
Unlock

5

6
5.

When the arrow is aligned with the unlock icon you can remove the rear top
cover 6 .

Figure 6 - 3
Rear Top Cover
Removal

6 - 4 Removing the Rear Top Cover
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Wireless Keyboard & Mouse USB Receiver
If your purchase includes an optional Wireless Keyboard & Mouse Kit you can use
the USB port located behind the rear top cover to house the USB receiver.
1.
2.
3.

Remove the rear cover (see “Removing the Rear Top Cover” on page 6 - 3).
Insert the USB receiver 1 into the USB port 2 .
Replace the rear top cover and screws.

6
2

1

Figure 6 - 4
USB Port for
Wireless Keyboard
& Mouse Kit

2
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HDD System
Warning

6

New HDD’s are blank. Before you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to install your operating system
and programs.
If you have access to the internet, download the latest
application and hardware
driver updates for the operating system you plan to install. Copy these to a
removable medium.

Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Driver Installation” on page 4 - 2), when setting up a new hard
disk.
1.
2.

Remove the rear cover (see “Removing the Rear Top Cover” on page 6 - 3).
Remove screws 1 - 3 .

1


Figure 6 - 5
Hard Disk Screws

Hard Disk Slot
Make sure you install the hard disk
into the lower slot on the mainboard.

6 - 6 Upgrading the Hard Disk Drive
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3.

Firstly slide the hard disk in the direction of arrow 4 , and then slide it in the
direction of arrow 5 to remove it.

5

Figure 6 - 6
Hard Disk Assembly
Removal

4

6
4.

Remove the adhesive hard disk cover 6 .

6

Figure 6 - 7
Hard Disk Cover
Removal

5.

Reverse the process to install a new hard disk.
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SODIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types).
The total memory size is automatically detected by the POST routine once you turn
on your computer.
1.
2.

6

Remove the rear cover (see “Removing the Rear Top Cover” on page 6 - 3).
The RAM is located at point 1 .

Figure 6 - 8
RAM Location

1
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3.

Gently pull the two release latches on the sides of the memory socket in the
direction indicated by the arrows ( 2 & 2 ) in Figure 6 - 9.


Contact Warning

4.
5.
6.

2

3

2

3

Be careful not to touch
the metal pins on the
module’s
connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

The RAM module will pop-up, and you can remove it.
Pull the latches to release the second module if necessary.
Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.
7. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.
8. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.
9. Replace the module bay cover and screws.
10. Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.

Figure 6 - 9
RAM Module
Removal
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Warranty
The CPU is not a user
serviceable part. Opening this compartment, or
accessing the CPU in
any way, may violate
your warranty.

6

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Unauthorized tampering
with the HDD may also
violate your warranty.
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.
•
•
•
•
•

Bluetooth Module
Wireless LAN Module
PC Camera Module
Touch Screen Module
Intel Turbo Memory Module

7
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Bluetooth Module
The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, printers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.
The operating system’s Bluetooth Devices control panel is used to configure the
Bluetooth settings in Windows Vista, and therefore does not require a driver.


Bluetooth Data Transfer

7

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in one direction only (simultaneous data transfer is not supported). Therefore
if you are copying a file from your computer to a Bluetooth enabled device, you will not be
able to copy a file from the Bluetooth enabled device to your computer until the file transfer
process from the computer has been completed.
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1.
2.

Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1.
2.

A Bluetooth icon will appear in the taskbar (see sidebar).
You can then do any of the following to access the Bluetooth Devices control
panel.
•
•

Double-click the icon
to access the Bluetooth Devices control panel.
Click Start, and click Control Panel (or point to Settings and click Control Panel), and then
click Bluetooth Devices (Hardware and Sound).

•

Click/Right-click the icon

and choose an option from the menu.


Bluetooth Taskbar
Icon
If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth
Devices
control panel. Click Options (tab), and make
sure that Show Bluetooth icon in the notification area check box
(Connections) has a
tick inside it.

Figure 7 - 1
Bluetooth Devices &
Click Icon Menu
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To Add a Bluetooth Device
1.
2.

Figure 7 - 2
Add Bluetooth
Device Wizard

3.
4.
5.

Access the Bluetooth Devices control panel.
Click Options (tab), and make sure that Allow Bluetooth devices to connect to
this computer check box (Connections) has a tick inside it.
Click Devices (tab), and then click Add.
The Add Bluetooth Device Wizard will appear.
Click to select “My device is set up and ready to be found”, and then click Next.

6.
7.
8.

The Wizard will then search for any available Bluetooth devices within range.
Click to select the device you want to communicate with, and click Next.
Select an appropriate passkey option and click Next.

9.

Click Finish.
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Passkey Options
You can allow the system to choose a passkey for you. You will
then be prompted to
enter the generated
passkey on your Bluetooth device.

Figure 7 - 3
Passkey Option
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To Change Settings for the Bluetooth Device
1.
2.



Access the Bluetooth Devices control panel.
Click on the device you want to change and click Properties to:
•
•

Change the name of the device (click General, type a new name and click OK).
Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1.
2.
3.

Access the Bluetooth Devices control panel.
Click Options, and make sure that Allow Bluetooth devices to find this
computer check box (Discovery) has a tick inside it.
Make sure that Alert me when a new Bluetooth device wants to connect check
box (Connections) has a tick inside it, if you want to be notified when a Bluetooth
device wants to connect.

Bluetooth Help
To get help on Bluetooth
configuration and settings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box,
and select an item from
the returned search results to get more information.

Figure 7 - 4
Bluetooth Devices
Options
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) WLAN
module, or 3rd Party 802.11b/g WLAN module in your purchase option, install the
driver as per the procedure overleaf.
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

7
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Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.
Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).

7
802.11b/g Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.
Note: The operating system is the default setting for Wireless LAN control in Windows Vista (see overleaf).
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Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on (see page 7 - 11).
1.

Click the taskbar wireless icon , and then click Connect to a network (or rightclick the icon , and then click Connect to a network).

Figure 7 - 5
Taskbar Menus
Click icon

Right-click icon


7

Network and
Sharing Center

2.
3.

In the Show list, click to choose Wireless from the drop-down menu.
A list of currently available networks will appear.

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 6
Connect to a
Network

7 - 8 Wireless LAN Module

Modules & Options
4.
5.

Click a network, and then click Connect.
If you do not see a network you want to connect to, click Set up a connection or
network (a list of options will appear allowing manual searching, and creating a
new network).

Figure 7 - 7
Connecting
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6.

Move the cursor over the taskbar icon

to see the connection status (see below).

Figure 7 - 8
Connection Status
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7.


Security Enabled
Networks

To disconnect from the wireless network you can click the taskbar wireless icon ,
and then select Connect or disconnect to access the network menu, and click
Disconnect (or right-click the icon , and then click Disconnect from).

You should try to make
sure that any network
you are connecting to is
a secure network.

7

Click icon

Connecting to unsecure
networks may allow unauthorized access to
your computer, documents, websites and
files etc.

Figure 7 - 9
Disconnecting
Right-click icon
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.
To access the Windows Mobility Center:
1.
2.
3.

Click Start, and click Control Panel (or point to Settings and click Control
Panel).
Double-click Windows Mobility Center (Mobile PC).
Click the button to Turn wireless off/on, or click the icon
to access the network
menu.

Figure 7 - 10
Windows Mobility
Center
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2.0M PC Camera
Screen Refresh

7

The 2.0M PC Camera
module
supports
a
frame rate of 12 fps. If
you find that the screen
refresh rate is subject to
lag or stuttering, then reduce the window size,
or adjust the Output
Size
and/or
Color
Space Compression.
To reduce Output Size
and/or Color Space
Compression run the
BisonCap application,
click Options and select
Video Capture Pin. Adjust the settings from the
appropriate pull-down
menu.

PC Camera Module
There PC Camera module uses the BisonCap application to capture video files. Install the driver as per the instructions below.


Latest PC Camera Driver Information
Check the Device Drivers & Utilities + User’s Manual disc, and any accompanying insert
pages, for the latest updated information on the PC Camera driver, which may override the
information provided here.

PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Camera Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the
desktop, or from the BisonCam item in the Start > Programs/All Programs menu.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to connect a
microphone to either of the microphone ports and then setup the audio recording options in Windows as follows.
1.
2.
3.
4.

Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound
(Hardware and Sound).
Click Recording (tab).
Right-click Microphone (for the microphone-in jack on the left side of the
computer) or FrontMic (for the microphone-in jack on the base of the computer)
and make sure the item is not disabled.
5. Double-click Microphone/FrontMic (or select Properties from the right-click
menu).
6. Click Levels (tab), and adjust the Microphone/FrontMic and Microphone Boost
sliders to the level required.
7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs
> BisonCam menu.
9. Go to the Devices menu heading and select Microphone/FrontMic (it should
have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).

PC Camera Module 7 - 13
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Figure 7 - 11
Audio Setup for PC
Camera
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Right-click
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BisonCap
BisonCap is a video viewer for general purpose video viewing and testing, and capturing video files to .avi format.
1.

2.
3.

Run the BisonCap program from the Start > Programs/All Programs > BisonCam menu (it is recommended that you set the capture file before the capture
process - see Set Capture File below).
Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page 7 - 13) and select Start Capture.
Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 16 in order to save file space, and help prevent system problems.


Pre-Allocating File
Space
You may pre-allocate
the file size (File > Allocate File Size) for the
capture file in the
BisonCap program.
Pre-allocating space on
the hard disk can improve the capture quality (particularly of large
capture files), by reducing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.
See also “Reducing
Video File Size” on
page 7 - 16.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

7

Note that the Windows Vista system requires a minimum of 15GB of free space on
the C: drive system partition. In order to prevent system problems it is recommended that you save the captured video file to a location other than the C: drive (see “Set
Capture File” on page 7 - 15), limit the file size of the captured video (see “PreAllocating File Space” on page 7 - 15) or reduce video resolution (see below).
To Reduce Video Resolution Output Size:
1.
2.
3.

Run the BisonCap program.
Go to Options and scroll down to select Video Capture Pin....
Click the Output Size drop box and select a lower resolution size in order to
reduce the captured file size.
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.
1.
2.
3.

Run the BisonCap program.
Go to Options and scroll down to select Video Capture Filter....
Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 12
Video Capture Filter
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Zoom
The BisonCap program allows you to zoom the camera in and out.
1.
2.

Run the BisonCap program.
Go to Zoom and select Zoom Out/Zoom In.

Figure 7 - 13
Zoom/Setting


Snapshot Folder

7

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

Taking Still Pictures
The BisonCap programs allows you to take still pictures.
1.
2.
3.

Run the BisonCap program.
Go to Options and select Take Picture.
The picture (in JPEG format) will be placed in the Snapshot folder
desktop.

If you accidentally delete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to capture the files.
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Touch Screen Module
If you have included a Touch Screen module in your purchase option, you should obtain a stylus pen to interact with the computer in the same way you would use a
mouse (use a stylus pen to tap/double-tap on-screen buttons etc.). Calibrate the touch
screen before using your stylus pen. Make sure you install the driver as indicated below.

Touch Screen Utility Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install TouchScreen Utility > Yes.
4. Click Install.
5. Click OK to restart the computer.


Touch Screen Input
Device
Do not use any sharp or
pointed objects as your
input device e.g. the end
of a pen or pencil. You
should preferably only
use a stylus pen (PDA
type) as your input device.
Be very careful not to
press too hard with the
stylus pen when using it
as the input device.

Touch Screen Module 7 - 19

7

Modules & Options

Calibrating the Touch Screen
1.

2.

Click Start, and click Programs/All Programs and point to Touch Utilities
(folder), and then click Touch Configuration program (or double-click the desktop icon
).
Click Calibration (button).

7
Figure 7 - 14
Touch Screen
Configuration
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3.

Click to choose the number of points in Calibration Precision, and then click
Calibrate (button).

Figure 7 - 15
Calibration Precision

7
4.

Use the stylus pen to touch the center of the cross sign until the OK sign appears
in the center of the cross.



Figure 7 - 16
Touch On Cross

Calibration Points
For maximum accuracy, make sure that you use the stylus
pen to touch the CENTER of the blinking target symbol
when calibrating the touch screen.
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5.

When the Test Drawing appears, write on the screen to test the calibration (press
the spacebar to clear any drawing, or Esc to exit).

6.
7.

Click Close to exit Calibration.
Click Touch Settings (button) to adjust any touch setting (mouse) options.

Figure 7 - 17
Test Drawing
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Figure 7 - 18
Touch Settings

-
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Tablet PC Input Panel
When not in use the Tablet PC Input Panel (not available in Windows Vista Home
Basic Edition) docks at the side of the screen (and may be docked at either side of
the screen at any height) with just a small portion visible. Move the pen over the TIC
and then tap it to activate it. The input panel allows you to input text without the use
of a keyboard. You can use the writing pad (write continuously), character pad
(write one character at a time) or on-screen keyboard to input text. Use the Help
menu for further information.

symbol pad & number pad


Tablet PC Settings
Tablet PC settings may be
customized from the Tablet
PC Settings in Windows
Vista (Windows Vista
Home Basic Edition does
not support Handwriting
Recognition). Access the
control panel as follows:
Click Start, and click Control Panel (or point to Settings and click Control
Panel).
Click Mobile PC and double-click Tablet PC Settings (or just double-click
Tablet PC Settings
).

Figure 7 - 19
Tablet PC Input
Panel & Tablet PC
Settings Control
Panel
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e-SATA Port
Support

7

Note that the Intel Matrix Storage driver is
required to enable the
e-SATA port even if you
have not included an Intel Turbo Memory module in your purchase
configuration.
Follow the instructions
provided here in order to
install the driver.

Intel Turbo Memory Module
If you have included an Intel Turbo Memory (Robson) NAND flash memory card
module in your purchase option, then you will need to install the driver as per the
instructions below (do not install this driver in Windows XP).
Intel Turbo Memory Technology (also known as Robson flash memory) is an Intel
technology that reduces the time it takes for a computer to boot up, to load applications, and to write data to the hard drive. Intel Turbo Memory Technology is supported in Windows Vista only (it also supports Windows Vista features such as
ReadyBoost, ReadyDrive, and Superfetch).

Intel Turbo Memory & Matrix Storage Setup and Driver Installation
1. Start-up the computer and press <F2> to enter the BIOS (see “The Setup
Program” on page 5 - 4).
2. Go to the Advanced menu, select "Installed O/S" and make sure "Vista" is
the selected option (see “Advanced Menu” on page 5 - 8).
3. Go to the "SATA Mode Selection" item and make sure "AHCI" is selected.
4. Go to the "DFOROM (Robson) Support" item and make sure "Enabled" is
selected.
5. Go to the Exit menu (see “Exit Menu” on page 5 - 15) and select "Exit
Saving Changes" (or press F10 and select "Yes" then press Enter) and
press Enter to exit the BIOS and reboot the computer.
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6. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
7. Click Option Drivers (button).
8. Click 4.Install TM&iMSM Driver > Yes.
9. Click Next > Yes > Next > Next.
10. Click Finish to restart the computer.
If you have a 4GB Turbo Memory Module (see below). For Turbo Memory Modules
less than 4GB (see overleaf):

1. Run the Intel® Turbo Memory Dashboard from the Programs/All Programs menu (Intel® Turbo Memory) or from the desktop shortcut.
2. The Intel® Turbo Memory Dashboard allows you to select files and
applications to accelerate and therefore open faster and display quicker.
3. Applications will be listed in the Applications pane window on the right.
4. To accelerate any application drag the icon into the Accelerated pane on
the left (the available memory is indicated in the top left).


Windows Security
Message
If you receive a Windows security message
as part of the driver installation process. Just
click “Install this driver
software anyway” or
“Install” to continue the
installation procedure.

Help
Click the Help icon
to
bring up the menu and
click to select and help
topic.

Figure 7 - 20
Intel Turbo Memory
Dashboard
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1. Run the Intel® Turbo Memory Console from the Programs/All Programs menu (Intel® Turbo Memory).

7
Figure 7 - 21
Intel Turbo
Memory Console

• Windows ReadyBoost - uses flash memory as a hard-drive caching solution.
• Windows ReadyDrive - uses hybrid drives as a hard-drive caching solution
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.
Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.

Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.
• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED & Hot
Key Indicators” on page 1 - 9) to see the computer’s power status.
• Connections - Check all the cables to make sure that there are no loose connections anywhere.
• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys configured in your Power Options, or power button, to wake-up the system.
• Brightness - Check the brightness of the screen by pressing the brightness buttons to adjust the brightness.

8

• Display Choice - Make sure the system is not set to “external only” display if an external display is
attached.
• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wallet.
• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.
• Write down your passwords and keep them safe (away from your computer). This is especially important if
you choose to use a Supervisor password for the BIOS (see “Security Menu” on page 5 - 12).
• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty
The CPU is not a user serviceable part. Accessing the CPU in any way, may violate your warranty.

Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.
• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within email attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowledge.

8

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS’s documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.
• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.
• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.
• When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.
• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are
usually available to download from vendor’s websites).

Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.
• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and
removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Problems & Possible Solutions
Problem

Possible Cause - Solution

The computer feels too
hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 12). Make sure
you’re using the correct adapter.

Nothing
screen.

The system is in a power saving mode. Press the power button or any configured sleep/resume
key combination.

appears

on

The screen controls need to be adjusted. Press the brightness buttons to adjust the settings. If
you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also
check any attached monitor’s own brightness and contrast controls.
The screen saver is activated. Press any key on the keyboard.
No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
for instructions on installing and configuring the video driver.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the volume buttons to adjust the setting (see “Audio Features” on
page 2 - 8/“Audio Features” on page D - 4) to adjust.

The compact disc cannot
be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

Problems & Possible Solutions 8 - 7

8

Troubleshooting
Problem

Possible Cause - Solution

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes
can
no
longer
be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5/
“DVD Regional Codes” on page D - 2.

You forget
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

the

boot


Password Warning

8

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.

A file cannot be copied
to/from a
connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed
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Problem

Possible Cause - Solution

The system “hangs” (a
blank screen appears
and the OS will not load)
at the POST/start up.

You have disabled AHCI mode in the BIOS. If you have installed the Windows Vista operating
system with AHCI mode enabled (default setting), DO NOT disable AHCI mode (if you wish to
disable AHCI mode you will need to reinstall the Windows VIsta OS). To correct this problem
press F2 at startup to enter the BIOS, enable AHCI mode, and then save the setting (see “SATA
Mode Selection (Advanced Menu)” on page 5 - 9).
Make sure you have selected the appropriate O/S for your system in the BIOS e.g. Windows
Vista/Windows XP etc. Setting the incorrect O/S can also cause the system to “hang” (see
“Installed O/S (Advanced Menu)” on page 5 - 9).

The Hibernate function
has disappeared.

You have a computer with 4GB of RAM and have installed Windows Vista Service Pack 1. This
is a known issue if your computer has 4GB of RAM and is running Windows Vista Service Pack
1. To re-enable Hibernate mode go to the Command Prompt and type the command “powercfg
-h on” (make sure you are logged on as an Administrator):

1.
2.
3.
4.
5.
6.

Click Start
(menu button).
Type “cmd” in the Start Search box
.
Double click the Command Prompt
when it appears in the menu.
Type “powercfg -h on” in the Command Prompt window.
Close the Command Prompt window.
The Hibernate function will now be enabled.
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8

Troubleshooting
Problem

Possible Cause - Solution

No sound can be heard
from the internal/external
speakers/headphones.

You have plugged in headphones or speakers to the audio jacks at the front of the computer.
Note that the system has two sets of audio jacks as well as internal speakers. All the audio jacks
cannot function at the same time and are therefore assigned a priority order depending on your
audio connections.
Priority 1 = The audio jacks at the front of the computer. Thus the audio jacks at the side of
the computer and the internal speakers are disabled (e.g if you connect headphones to the
headphone-out jack at the front of the computer then speakers/headphones connected to the
headphone-out jack at the side of the computer are disabled).
Priority 2 = The audio jacks at the side of the computer. Thus the internal speakers are
disabled (e.g if you connect speakers to the headphone-out jack at the side of the computer then
the internal speakers are disabled).
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Priority 3 = The internal speakers. If there are no audio connections to any of the audio jacks,
then the audio output will default to the internal speakers.
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
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Computer Ports and Jacks
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Item

Description

Card Reader Port

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

COM/Serial Ports

The COM/serial is a communication interface for data transfer, through which information
transfers in or out one bit at a time. This port can be used to connect the computer to devices
such as terminals and peripherals.

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

e-SATA Port

Plug external Serial ATA hard drives into this e-SATA (external Serial Advanced Technology
Attachment) port.
Not: The eSATA port only supports hot-swapping if you have selected AHCI mode in SATA Mode
Selection in the BIOS (see “SATA Mode & eSata Port” on page 5 - 10), enabled DOFORM support (see “DFOROM (Robson) Support (Advanced Menu > SATA Mode Selection [AHCI]” on
page 5 - 10) and installed the Intel Matrix Storage driver (see “Intel Turbo Memory & Matrix Storage Setup and Driver Installation” on page 7 - 24). If you have selected IDE mode, then hotswapping devices connected to the eSATA port is not supported.
Note that hot-swapping is NOT supported in the Windows XP O/S.
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Item

Description

External Monitor (VGA)
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD (see “Configuring Other Displays
from Intel® GMA Driver for Mobile” on page B - 6).

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device (see “Attaching Other Displays” on page B - 5) by
means of a HDMI cable. Note that HDMI carries both audio and video signals.
Note the HDMI configuration for audio output (see “HDMI Audio Configuration” on page B - 7).

Headphone-Out Jack

Line-In Jack

Microphone-In Jack

Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

The Line-In jack allows you to play audio sources through the computer’s speakers.

Plug an external microphone in to this jack to record on your computer.

Interface (Ports & Jacks) A - 3
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Item

Description

Mini-IEEE 1394 Port

This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).


IEEE 1394
The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.

RJ-11 Phone Jack

RJ-45 LAN Jack

This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

A
Security Lock Slot

To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S/PDIF-Out Jack

This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVDcapable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.
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Item

Description

USB 2.0/1.1 Ports

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

A
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Appendix B: Intel Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 14.


DVMT Notes

Intel Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

DVMT is not local video
memory.
DVMT is not user-configurable.
DVMT will not function
in MS-DOS. DOS uses
the legacy memory indicated.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much system memory
(RAM) as needed to the video system (the video driver must be installed). DVMT
returns whatever memory is no longer needed to the operating system.

Intel Video Driver Installation B - 1
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Taskbar Icon
The Intel GMA control
panel can also be accessed by clicking the
icon
in the taskbar
and selecting Graphics
Properties from the
menu.

Intel Graphics Properties
More advanced video configuration options are provided by the Intel(R) Graphics
Media Accelerator Driver for mobile control panel.
1.
2.

Open the Display Settings control panel (see “Video Features” on page 1 - 14)
and click Advanced Settings (button).
Click the Intel(R)... tab and click Graphics Properties (button).

If you cannot see the
tray icon click the “Show
Tray Icon” tickbox in the
Intel(R) Graphics Media Accelerator for Mobile tab.

B

Figure B - 1
Intel Graphics
Properties
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking
the appropriate menu item or button.


Help Menus
Right-click on many of
the items in the tabs to
bring up the “What’s
This?” button.
Click
the
“What’s
This?” button to bring
up the help menu.

Display Selection
At least one other display must be attached in
order to view multiple
Display Selection options.

Figure B - 2
Intel Graphics Media
Accelerator Driver
for mobile
(Control Panel Tabs)
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Application.exe
You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application rightclick its shortcut on the
desktop click Properties. Click the Shortcut
(tab) and see where the
executable file is located
by clicking the Find Target (button). Note the location and you will then
be able to browse to this
file.

B
Figure B - 3

Scheme Options
Use Scheme Options to configure quick settings for applications which require specific resolution and color settings in order to run properly e.g. games, multimedia
programs. To set the scheme options:
1.
2.
3.

Open the Display Settings control panel and click Advanced Settings (button).
Click the Intel(R)... tab and click Graphics Properties (button).
Configure your display configuration, resolution etc. as per your requirements from
Display Settings.
4. Click on Scheme Options (button).
5. Type a name for the scheme then click Save.
6. If you want to automatically launch an application when the scheme is applied,
click the tickbox (“Automatically launch an application when the scheme is
applied”) and then click on Browse (button).
7. Browse to the executable file for the application you want to set the scheme for
(see sidebar), and click Open to select it.
8. Click Save (Save > OK) to save the settings (you can click in the "Restore the
display settings after exiting this application" box to return to your original
settings when you exit the program).
9. Click OK to exit the window.
10. Click the taskbar icon and Select Scheme to run the scheme.

Select Scheme
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Attaching Other Displays
Besides the built-in LCD you can also use an external monitor/flat panel display/TV
(TV through HDMI-Out port only), connected to the external monitor port or to the
HDMI-Out port (High-Definition Multimedia Interface) as your display device. The
following are the display options:
1.
2.

The built-in LCD OR an external monitor/flat panel display connected to the external monitor port or HDMI-Out port (Single Display).
The built-in LCD AND an external monitor/flat panel display connected to the
external monitor port or HDMI-Out port (Multiple Display).


HDMI
Note that HDMI supports video and audio
signals (see page B - 7).

Configuring Other Displays from Windows Vista
1.
2.
3.

Attach your external display to the external monitor port or HDMI-Out port, and
turn it on.
Go to the Windows Mobility Center control panel (Mobile PC > Adjust
commonly used mobility settings) and click Connect display.
Click on any of the buttons to configure the displays to your preference, or click
Display Settings to access the control panel.

Figure B - 4
Windows Mobility
Center & New
Display Detected
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Configuring Other Displays from Intel® GMA Driver for Mobile


Display Selection
At least one other display must be attached in
order to view multiple
Display Selection options.

1.
2.
3.
4.
5.

Attach your external display to the external monitor port or HDMI-Out port, and
turn it on.
Go to the Intel(R) GMA Driver for mobile control panel (see “Intel Graphics
Properties” on page B - 2) and click Display Devices.
Click to choose the display mode from the Operating Mode menu.
Choose which device is to be the Primary Device/Secondary Device from the
Display Selection menu.
Click Apply (and OK to confirm the settings change) and OK (button).

Figure B - 5
Display Devices

B
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you will need to configure the audio output as per the instructions below.
Windows Audio Setup for HDMI
1.
2.
3.
4.
5.
6.

Connect a device with HDMI support to the HDMI-Out port.
Click Start, and click Control Panel (or point to Settings and click Control Panel).
Click Sound
(Hardware and Sound).
Click Playback (tab), and click to select HDMI Device.
Click Set Default (button).
Click OK to close the Sound
control panel.

Figure B - 6
HDMI Device

Click the taskbar volume indicator
when HDMI Device is selected, and you will
note that the icon at the top
of the volume level indicator
has changed.

HDMI Audio Configuration B - 7
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HDMI Notes


Other Applications
If you are using a third
party application to
play DVDs etc. you will
need to consult the application’s documentation
to
see
the
appropriate audio configuration (the application must support
digital to analog translation).

• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.
• If you disconnect the HDMI cable the default audio playback device will not
revert to speakers until the computer is restarted (if you do not wish to restart the
computer then go to the Sound control panel and select Speakers as the default
audio playback device).
HDMI Video Configuration
1.
2.
3.
4.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Configuring Other
Displays from Intel® GMA Driver for Mobile” on page B - 6.
Set up your external display (TV or LCD) for HDMI input (see your display device
manual).
You can now play video/audio sources through your external display.

B
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Display Modes
Single Display
Only one of your attached displays is used.
Intel(R) Dual Display Clone (mirrored)
This mode will drive multiple displays with the same content. Each device may be
configured independently for different resolutions, refresh rates, color quality etc.
Use this feature to display the screen through a projector for a presentation.


Video Settings
Click Video Settings
(button) in the Intel(R)
GMA Driver for mobile
control panel to access
settings for Video Quality, Color Control and
Video Scaling.

Extended Desktop (extended)
This mode allows a desktop to span multiple displays and acts as a large workspace.
This creates a lot more screen area for display. Use the Display Properties control
panel to drag the monitors to match the physical arrangement you wish to use, or you
may also use the Extended Desktop Settings control panel tab in Graphics Properties to configure the relative size and position.

B
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To Enable Intel(R) Dual Display Clone
1.
2.
3.
4.
5.
6.

Figure B - 7
Display Devices &
Settings

B
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Attach your external display to the external monitor port or HDMI-Out port, and
turn it on.
Go to the Intel(R) GMA Driver for mobile control panel (see “Intel Graphics
Properties” on page B - 2) and click Display Devices.
Click to choose Intel(R) Dual Display Clone (Operating Mode).
Choose which device is to be the Primary Device/Secondary Device from the
Display Selection menu.
Click Apply, and OK to confirm the settings change.
Click Display Settings to adjust the settings for the attached devices.

Intel Video Driver Controls

To Enable Extended Desktop
1.
2.
3.
4.
5.
6.

Attach your external display to the external monitor port or HDMI-Out port, and
turn it on.
Go to the Intel(R) GMA Driver for mobile control panel (see “Intel Graphics
Properties” on page B - 2) and click Display Devices.
Click to choose Extended Desktop (Operating Mode).
Choose which device is to be the Primary Device/Secondary Device from the
Display Selection menu.
Click Apply, and OK to confirm the settings change.
Click Display Settings to adjust the settings for the attached devices.

Click the appropriate monitor icon and drag it to match
the physical arrangement
you wish to use (e.g. the
secondary display may be
extended left/right/above/
below the primary display).
Click Display Settings to
make any adjustments required.


Display Settings
Extended Desktop
You can have different
Color Quality, Screen
Resolution and Refresh Rate settings for
each display device provided your device can
support them.
You can drag the monitor icons to match the
physical layout of your
displays. Icons and programs may also be
dragged between the
displays.

B
Figure B - 8
Extended Desktop
Mode
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Using Windows Vista to Enable Extended Mode



1.

Display Settings
Extended Desktop

2.

Use the control panel to
drag the monitors to
match the physical arrangement you wish to
use.

3.
4.
5.

You can drag any icons
or windows across to either display desktop,
which makes it possible
to have one program
visible in one of the displays, and a different
program visible in the
other display.

B
Figure B - 9
Display Properties
(Extended Desktop)
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Attach your external display to the external monitor port or HDMI-Out port, and
turn it on.
If a New Display Detected window does not appear in Windows Vista, go to the
Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.
Click to select Show different parts of my desktop on each display (extended).
Click Right or Left under Extend your desktop.
Click Apply > OK.

Intel Video Driver Controls

Using Display Settings to Enable Extended Mode
1.
2.
3.

Attach your external display to the external monitor port or HDMI-Out port, and
turn it on.
Open the Display Settings control panel (see “Video Features” on page 1 - 18).
Click the monitor icon (e.g. 2 ), and make sure you have checked “Extend the
desktop onto this monitor” and click Apply.

Click the appropriate monitor icon
(e.g. 2 ) to be able to select the option to extend the desktop on to it.

Figure B - 10
In this example the Primary Display 1 is on the left, the Secondary
Display 2 is on the right.

Display Properties
(Extended Desktop)

B
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Appendix C: Specifications

Latest Specification Information
The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed or updated due to the manufacturer's release schedule. Check with your
service center for details.
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Processor

C

Specification
Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
TDP: 35W
T9400/ T9600

45nm (45 Nanometer) Process Technology
6MB On-die L2 Cache & 1066MHz FSB
2.53/ 2.8 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
TDP: 25W
P9500

45nm (45 Nanometer) Process Technology
6MB On-die L2 Cache & 1066MHz FSB
2.53 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package, Socket P
TDP: 25W
P8400/ P8600

45nm (45 Nanometer) Process Technology
3MB On-die L2 Cache & 1066MHz FSB
2.26/ 2.40 GHz

Core Logic

Intel GM45 + ICH9M Chipset

LCD

19" WXGA+ (1440*900) Flat Panel TFT
Hard Glass (Factory Option)
Touch Panel (Factory Option)

Memory

Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 667 MHz/ 800 MHz
64-bit Wide DDRII (DDR2) Data Channel
Memory Expandable up to 4GB (1024/ 2048 MB DDRII Modules)
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Specifications
Feature

Specification

Video Adapter

Intel GM45 Integrated Video
Intel® Gen 5.0 Integrated Graphics Engine
Integrated High Definition Multimedia Interface (HDMI)
Supports DirectX10 3D Graphics Engine Accelerator

BIOS

One 32Mb Flash ROM

Storage

One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page C - 5 for
drive options) with SATA (Serial) Interface
Changeable 2.5" 9.5 mm (h) HDD with SATA (Serial) Interface

Audio

Intel High Definition Audio Interface (HDA)
3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible

S/PDIF Digital Output
2 * Built-In Speakers

Security

Security (Kensington® Type) Lock Slot

BIOS Password

Keyboard

Standard USB Keyboard (Option) or RF Keyboard with Receiver (Option)

Interface

Five USB 2.0 Ports (Three for VESA Support)
One HDMI-Out Port
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF Output Jack
One eSATA Port (IDE mode only and does not
support

Phoenix™ BIOS

One RJ-11 Jack for Plug & Play Fax/Modem
One RJ-45 Jack for 10Mb/ 100Mb Fast Ethernet
One DC-in Jack
One External Monitor Port
One Mini-IEEE 1394a Port
One Line-In Jack
Two COM Ports

Specifications C - 3
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Specification

Card Reader

Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo)
Note: MS Duo/ Mini SD/ RS MMC Cards Require a PC Adapter

ExpressCard Slot

ExpressCard/34/54 Slot

Mini-Card Slots

One Mini-Card Slot for Wireless LAN Module

Communication

Built-In 56K MDC Plug & Play Fax/Modem v.90/92 Compliant
Built-In Gigabit Ethernet LAN
Bluetooth 2.0 + EDR (Enhanced Data Rate) Module (Factory Option)
1.3M or 2.0M Pixel USB PC Camera Module (Factory Option)
Wireless LAN Module Options:
Intel® WiFi Link 5300 Series (3*3 - 802.11a/g/n) Wireless LAN Mini-Card Module (Option)
Intel® WiFi Link 5100 Series (1*2 - 802.11a/g/n) Wireless LAN Mini-Card Module (Option)
3rd Party 802.11b/g Wireless LAN MiniCard Module with USB Interface (Option)

C

Power
Management

Supports ACPI 3.0

Power

Full Range AC/DC Adapter – AC in 100 - 240V, 50 - 60Hz DC Output 19V, 4.74A (90 Watts)

Environmental
Spec

Temperature
Operating:
Non-Operating:
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Supports Wake on LAN
Supports Resume from Modem Ring

5°C ~ 35°C
-20°C ~ 60°C

Relative Humidity
Operating:
Non-Operating:

20% ~ 80%
10% ~ 90%

Specifications
Feature

Specification

Dimensions &
Weight

450mm (w) * 312mm (d) * 66.5mm (h)

11kg

Optional

Combo Drive Module
DVD Dual (Super Multi) Drive Module

1.3M or 2.0M Pixel USB PC Camera Module
(Factory Option)

Wireless LAN Module:
Intel® WiFi Link 5300 Series (3*3 - 802.11a/g/n)
Wireless LAN Mini-Card Module (Option)
Intel® WiFi Link 5100 Series (1*2 - 802.11a/g/n)
Wireless LAN Mini-Card Module (Option)

Bluetooth 2.0 + EDR (Enhanced Data Rate)
Module (Factory Option)

3rd Party 802.11b/g Wireless LAN MiniCard
Module with USB Interface (Option)

C
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Appendix D: Windows XP Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows XP OS.
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DVD Regional Codes

Changing DVD Regional Codes
Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives.
Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control
panel to allow you to adjust the regional code.
DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.

Region

D

Geographical Location

1

USA, Canada

2

Western Europe, Japan, South Africa, Middle East & Egypt

3

South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong
Kong

4

South & Central America, Mexico, Australia, New Zealand

5

N Korea, Russia, Eastern Europe, India & Most of Africa

6

China

Table D - 1 - DVD Region Codes
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Figure D - 1 - DVD Regions
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

Click here to toggle Category View

Figure D - 2 - Start Menu & Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Windows XP Start Menu & Control Panel D - 3
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio Devices
Windows control panel, or from the Realtek HD Audio Manager icon in the taskbar/control panel (this will bring up the
Realtek Audio Configuration menus).


Sound Volume Adjustment
How high the sound volume can be
set depends on the setting of the volume control within Windows (and the
volume control function keys on the
computer). Click the Volume icon on
the taskbar to check the setting.

D

Figure D - 3 - Realtek Audio Configuration Menus
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Audio Jacks
Note that the system has two sets of audio jacks as well as internal speakers. All the audio jacks cannot function at the same time and are therefore assigned a priority order depending on your audio connections.
• Priority 1 = The audio jacks at the front of the computer. Thus the audio jacks at the side of the computer
and the internal speakers are disabled (e.g if you connect headphones to the headphone-out jack at the front
of the computer then speakers/headphones connected to the headphone-out jack at the side of the computer
are disabled).
• Priority 2 = The audio jacks at the side of the computer. Thus the internal speakers are disabled (e.g if
you connect speakers to the headphone-out jack at the side of the computer then the internal speakers are
disabled).
• Priority 3 = The internal speakers. If there are no audio connections to any of the audio jacks, then the
audio output will default to the internal speakers.

D
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Video Features
You can switch display devices, and configure display options, from the Display Properties control panel in
Windows as long as the appropriate video driver is installed.
To access Display Properties in Windows:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Click Start, point to Settings and click Control Panel (or just click Control Panel).
Double-click Display (icon) - In the Appearances and Themes category.
Click Settings (tab) in the Display Properties dialog box.
Move the slider to the preferred setting in Screen resolution 1 (Figure D - 4 on page D - 7).
Click the arrow, and scroll to the preferred setting in Color quality 2 (Figure D - 4 on page D - 7).
You can also access Display Properties by right-clicking the desktop and scrolling down and clicking
Properties. Click Settings (tab) and adjust as above.
Open the Display Properties control panel, and click Advanced (button) 3 (Figure D - 4 on page D - 7) to
bring up the Advanced properties tabs.
Click the Intel(R) Graphics Media Accelerator Driver for Mobile tab, and click Graphics Properties (button)
to make any video adjustments you require.
You can also access Graphics Properties from the Windows Intel(R) GMA Driver for Mobile control panel,
or from the taskbar icon .

Dynamic Video Memory Technology

D

Intel® DVMT automatically and dynamically allocates as much system memory (RAM) as needed to the video
system (the video driver must be installed). DVMT returns whatever memory is no longer needed to the operating system.
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Display & Graphics Properties


Taskbar Icon
You can also access the controller properties from the taskbar. Click on the icon
to bring up the menu and scroll to
Graphics Properties.
If you cannot see the tray icon go to the
Intel(R) Graphics Media Accelerator
Driver for Mobile tab and click the
“Show Tray Icon” tickbox. Alternatively
right-click the desktop and select Graphics Options > Tray Icon > Enable.

1

2

3

D
Figure D - 4 - Display & Graphics Properties
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You may make changes to the devices, color, schemes, Hot Keys etc. by clicking the appropriate menu item or
button.


Help Menus
Right-click on many of the items
in the tabs to bring up the
“What’s This?” button.
Click the “What’s This?” button
to bring up the help menu.

D

Figure D - 5 - Intel GMA Driver for Mobile
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Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT) or external Flat Panel Display
as your display device. A VGA monitor/Flat Panel Display connects to the external monitor port. The following
display modes are available.
Intel Display Mode

Description

Single Display

One of the connected displays is used as the display device

Multiple Display - Intel(R)
Dual Display Clone

Both connected displays output the same view and may be configured independently

Multiple Display - Extended
Desktop

Both connected displays are treated as separate devices, and act as a virtual desktop

Figure D - 6 - Display Options

D
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Display Selection
At least one other display must be attached in
order to view multiple
Display Selection options.

Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor
port on the left of the computer.
1.
2.
3.
4.

Attach your external display to the external monitor port, and turn it on.
Go to the Intel(R) GMA Driver for mobile control panel and click Display Devices.
Click to choose the display option from the Operating Mode menu.
Click Apply, and OK to confirm the settings change.

Figure D - 7
Display Devices

D
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To Enable Intel(R) Dual Display Clone (Intel GMA)
1.
2.
3.
4.
5.

Attach your external display to the external monitor port, and turn it on.
Go to the Intel(R) GMA Driver for mobile control panel and click Display Devices.
Click to choose Intel(R) Dual Display Clone (Operating Mode).
Click Apply, and OK to confirm the settings change.
Click Display Settings to adjust the settings for the attached devices.

Figure D - 8 - Display Devices - Intel(R) Dual Display Clone
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To Enable Extended Desktop (Intel GMA)
1.
2.
3.
4.
5.

Attach your external display to the external monitor port, and turn it on.
Go to the Intel(R) GMA Driver for mobile control panel and click Display Devices.
Click to choose Extended Desktop (Operating Mode).
Click Apply, and OK to confirm the settings change.
Click Display Settings to adjust the settings for the attached devices.

Click the appropriate
monitor icon and drag
it to match the physical
arrangement you wish
to use (e.g. the Secondary Device may be extended left/right/above/
below the Primary Device).


Display Settings
Extended Desktop
You can have different
Colors, Screen Area and
Monitor Refresh Rates for
each display device provided your monitor can
support them.
You can drag the monitor
icons to match the physical layout of your displays.
Icons and programs may
also be dragged between
the displays.

D

Click Display Settings
to make any adjustments required.

Figure D - 9 - Display Devices - Extended Desktop
D - 12 Attaching Other Displays

Windows XP Information
To Enable Extended Desktop (Windows Display Properties)
1.
2.
3.
4.
5.

Attach your external monitor to the external monitor port, and turn it on.
Click Start, point to Settings (or click Control Panel) and click Control Panel (if you are in Category View
choose Appearance and Themes).
Double-click Display (icon).
In the Display Properties dialog box, click Settings (tab).
Click the monitor icon (e.g. 2 ), and make sure you have checked “Extend my Windows desktop onto this
monitor.” and click Apply.

Click the appropriate monitor icon (e.g. 2 ) to be able
to select the option to extend the desktop on to it.
In this example the Primary
Display 1 is on the left, the
Secondary Display 2 is on
the right.


Display Settings Extended
Desktop
Use the control panel to drag the monitors to match the physical arrangement you wish to use.
You can drag any icons or windows
across to either display desktop,
which makes it possible to have one
program visible in one of the displays,
and a different program visible in the
other display.

Figure D - 10 - Display Properties (Extended Desktop)
Attaching Other Displays D - 13

D

Windows XP Information

HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video signals you will need to configure the audio output as per the instructions below.
Windows Audio Setup for HDMI
1. Connect a device with HDMI support to the HDMI-Out port.
2. Go to the Start menu and point to Settings (or just click Control Panel) and click
Control Panel, then double-click the Sounds & Audio Devices icon (Sounds,
Speech, and Audio Devices in Category View).
3. Click Audio (tab).
4. Click Default device (Sound Playback) and select HDMI Device.
5. Click OK to close the control panel (see overleaf).

Figure D - 11
Sounds and Audio
Devices Properties

D
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HDMI Notes

• Connect a device with HDMI support to the HDMI-Out port BEFORE attempting to play audio/video sources through the device.
• If you disconnect the HDMI cable the default audio playback device will not
revert to speakers until the computer is restarted (if you do not wish to restart the
computer then go to the Sound control panel and select Speakers as the default
audio playback device).
HDMI Video Configuration
1.
2.
3.
4.

Connect an HDMI cable from the HDMI-Out port to your external display.
Configure your external display as per the instructions in “Attaching Other
Displays” on page D - 10.
Set up your external display (TV or LCD) for HDMI input (see your display device
manual).
You can now play video/audio sources through your external display.


Other Applications
If you are using a third
party application to
play DVDs etc. you will
need to consult the application’s documentation
to
see
the
appropriate audio configuration (the application must support
digital to analog translation).

D
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Shutdown
Note that you should
always shut your computer down by choosing the Shut Down/
Turn Off Computer
command from the
Start menu in Windows. This will help
prevent hard disk or
system problems.

Power Management
The computer uses the ACPI power management system to conserve power by controlling individual components of the computer (the monitor and hard disk drive) or
the whole system.
Using some form of power management greatly increases the life span of the
LCD.
When the computer is on, you can use the power button as a Standby/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding
the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off
If the system “hangs”,
and the Ctrl + Alt + Del
key
combination
doesn’t work, press the
power button for 4 seconds, or longer, to
force the system to
turn itself off.

D
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Power Schemes
You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Standby or
Hibernate modes (see “System Power Options” on page D - 18).


Resuming
Operation
The system can resume from Monitor or
Hard Disk Standby by
pressing a key on your
keyboard.

Figure D - 12
Power Schemes

D
Choose the Home/Office Desk scheme for maximum performance.
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Power Button as
Standby or
Hibernate Button
Fully ACPI-compliant
operating
systems,
(such as Windows
XP) allow you to use
the OS’s “Power Options” control panel to
set the power button to
send the system into
Standby or Hibernate
mode (see your OS’s
documentation,
or
“Configuring
the
Power Button” on
page D - 20 for details).

System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. This system features Standby and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hibernate tab
in the Power Options control panel - Figure D - 13 on page D - 19).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to
press the power button to turn it on. Their main difference is:
When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.
You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on
standby instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Standby mode.

D
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Standby
Standby saves the least amount of power, but takes the shortest time to return to full
operation. During Standby the hard disk is turned off, and the CPU is made to idle at
its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Standby mode to save power.


System Resume
The system can resume
from Standby mode by:
• Pressing
button

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

the

power

• An alarm resume that
is enabled and expires
• An
incoming
call
received
on
the
modem (if enabled)
• Network card activity
(if enabled)

Figure D - 13
Enable Hibernation

D
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Configuring the Power Button
The power button may be set to send the computer in to either Standby or Hibernate
mode. In Standby mode, the Power LED will blink green. In Hibernate the LED
will be orange. If the only the display is turned off, the LED will remain green.

Figure D - 14
Power Options
(Advanced - Power
Buttons)

Power Button

D
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Sleep/Resume (Sleep) Button
(if your keyboard supports this function)
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM, click Install Drivers/Option Drivers (button) and then click the appropriate driver name from
the Drivers Installer menu. Follow the instructions to
install the driver. Alternatively click Start, navigate
(Browse..) to the executable file and then follow the
manual setup instructions.

1.

2.

3.

Check the driver installation order from Table 5 (the
drivers must be installed in this order) which is
the same as that listed in the Drivers Installer
menu below.
Click to select the driver you wish to install, after
installing each driver it will become greyed out (if
you need to reinstall any driver, click the Unlock
button).
Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

D
Figure D - 15 - Drivers Installer Screen 1

Figure D - 16 - Drivers Installer Screen 2
Driver Installation D - 21
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Updating/Reinstalling Individual Drivers
WinXP SP2 Driver

Page #

Chipset

Page D - 23

Video

Page D - 23

Audio

Page D - 23

Modem

Page D - 24

LAN

Page D - 24

CardReader

Page D - 24

Hot Key

Page D - 24

Wireless LAN Module

Page D - 25

PC Camera Module

Page D - 35

Touch Screen Module

Page D - 41

Table 5 - Driver Installation

D
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If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and doubleclick the Add/Remove Programs item. If you see the
individual driver listed (if not see below), uninstall it,
following the on screen prompts (it may be necessary to
restart the computer). Go to the appropriate section of the
manual to complete the update/reinstall procedure for the
driver in question.
If the driver is not listed in the Add/Remove Programs
item:
1. Click Start (menu), point to Settings and click Control
Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in
Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the
driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver
tab) and follow the on screen prompts.

Windows XP Information

Driver Installation Procedure


Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or a
Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.
If you have upgraded the system by installing Service
Pack 2 (i.e. your Windows XP version does not include
Service Pack 2) then follow these instructions:

1.Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2.Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3.Click the Hardware (tab) > Device Manager (button).
4.Click “+” next to Other Devices (if its sub-items are
not shown).
5.Right-click Universal Serial Bus (USB) Controller
and select Uninstall > OK (if you don’t see the item
then there is no need to take any further action).
6.Restart the computer and it will find the USB 2.0 controller.

Insert the Device Drivers & Utilities + User’s Manual
disc, click Install Drivers/Option Drivers (button) and
then click the appropriate driver name from the Drivers
Installer menu.

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.
Video
1. Click 2.Install Video Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.
Audio
1. Click 3.Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.
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Modem
1. Click 4.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.


Modem Country Selection
Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem
Options).

LAN
1. Click 5.Install LAN Driver > Yes.
2. Click Next.
3. Click Install > Finish.
4. The network settings can now be configured.
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CardReader
1. Click 6.Install CardReader Driver > Yes.
2. Click Next > Install.
3. Click Finish.
Hot Key
1. Click 7.Install Hotkey Utility > Yes.
2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
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Optional Drivers

Bluetooth Module

See the pages indicated for the driver installation procedures for any modules included in your purchase option. Insert the Device Drivers & Utilities + User’s
Manual disc and click Option Drivers (button) to access the optional driver menu.

Note: The operating system is the default setting for
Bluetooth control in WindowsXP, and does not require
a driver. See “Bluetooth Module” on page D - 26 for
configuration instructions.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page D - 31, and check the installation procedure.

PC Camera Module
See the introduction in “PC Camera Module” on
page D - 35, and check the installation procedure.

Touch Screen Module
See the introduction in “Touch Screen Utility Installation” on page D - 41, and check the installation procedure.

Figure D - 17 - Optional Drivers

D
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Bluetooth Module
The operating system’s Bluetooth Devices control panel is used to configure the Bluetooth settings in Windows
XP, and therefore does not require a driver..


Bluetooth Data Transfer
Note that transferring data between the computer and a
Bluetooth enabled device is supported in one direction
only (simultaneous data transfer is not supported).
Therefore if you are copying a file from your computer to
a Bluetooth enabled device, you will not be able to copy
a file from the Bluetooth enabled device to your computer until the file transfer process from the computer has
been completed.

D
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Bluetooth Local Area Connection Icon
If you want to display the Local Area Connection icon for the Bluetooth connection in the taskbar, set it up as
follows:
1.
2.
3.
4.

Access the Network Connections control panel in Windows (Start > Settings > Network Connections OR
Start > Connect To > Show all Connections) or by clicking the taskbar icon
.
Right-click the Bluetooth connection icon, and select Properties.
Click to put a tick (if none is present) in the “Show icon in the notification area when connected” box and
click OK.
Close the control panels and the icon
for the Bluetooth local area connection will be displayed in the taskbar
when connected (see sidebar and overleaf).
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Bluetooth Configuration in Windows XP


Bluetooth Taskbar
Icon
If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth
Devices
control panel. Click Options (tab), and make
sure that Show Bluetooth icon in the notification area check box
has a tick inside it.

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. A Bluetooth icon will appear in the taskbar (see sidebar).
2. You can then do any of the following to access the Bluetooth Devices control
panel.
•
•

Double-click the icon to access the Bluetooth Devices control panel.
Click Start, and click Control Panel (or point to Settings and click Control Panel), and then click Bluetooth Devices (Network and Internet Connections).

•

Click/Right-click the icon

Figure D - 18
Bluetooth Devices &
Click Icon Menu
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and choose an option from the menu.
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To Add a Bluetooth Device
1.
2.
3.
4.
5.

Access the Bluetooth Devices control panel.
Click Options (tab), and make sure that Allow Bluetooth devices to connect to
this computer check box (Connections) has a tick inside it.
Click Devices (tab), and then click Add.
The Add Bluetooth Device Wizard will appear.
Click to select “My device is set up and ready to be found”, and then click Next.

Figure D - 19
Add Bluetooth
Device Wizard


Passkey Options

6.
7.
8.

The Wizard will then search for any available Bluetooth devices within range.
Click to select the device you want to communicate with, and click Next.
Select an appropriate passkey option and click Next.

You can allow the system to choose a passkey for you. You will
then be prompted to enter the generated passkey on your Bluetooth
device.

Figure D - 20
Passkey Option
9.

Click Finish.
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:
•
•

Change the name of the device (click General, type a new name and click OK).
Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Turn discovery on check box (Discovery) has
a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check
box (Connections) has a tick inside it, if you want to be notified when a Bluetooth
device wants to connect.

Figure D - 21
Bluetooth Devices
Options
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Wireless LAN Module
If you have included an Intel® Wi-Fi Link 5100/5300 Series (802.11 a/g/n) WLAN or 3rd Party 802.11 b/g
WLAN module in your purchase option, install the driver as outlined in the following pages.


Download Prerequisite Files for Intel WLAN
Before beginning the Intel® Wi-Fi Link 5100/5300 Series driver installation process for Windows XP it is necessary to
make sure you have a working internet connection. You will then be pointed to download the required Windows Installer
3.1 and Microsoft MSXML 6.0 files.
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Intel WLAN Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD drive.
2. Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next to link to the required prerequisites on the internet.
5. Click Download (button) to download the Windows Installer executable (.exe) file to the computer’s
hard disk.
6. Double-click (or click the Run button) to install the Windows Installer file and follow the on-screen
instructions for file installation.
7. You will be required to restart the computer to complete the file installation.
8. Repeat steps 1 to 4 to get to the appropriate download location.
9. Click Download (button) to download the Microsoft MSXML file to the computer’s hard disk (if you
are unsure of which file to download for you processor you can click Run instead of acknowledging
the file, and you will be informed if the file is appropriate or not).
10. Follow the on-screen instructions for file installation.
11. After the files have been installed click Next > Next.
12. Click the button to accept the license and click Next > Next > Next.
13. Click Finish to complete the installation.
14. Configure the settings by going to the Intel PROSet Wireless WiFi Connection Utility (Start > Programs/All Programs > Intel PROSet Wireless WiFi Connection Utility), or by double-clicking the
taskbar icon
.
15. Click to select any available network, and click Connect to establish a connection.
16. If you do not see your Wireless Access Point click Refresh (button).
17. Click Help (link) to bring up the Help Menu.
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18. Make sure that the WiFi On button is selected.

Figure D - 22 - Intel PROSet Wireless WiFi Connection Utility
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Network
Connection
Use the Windows Network
Connections
control panel to access
available wireless networks (Start > Settings
> Network Connections or Start > Connect To > Show all
Connections).

802.11b/g WLAN Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/DVD
drive.
2. Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.
7. The operating system is the default setting for Wireless LAN control in Windows XP.
8. Access any available wireless networks from Network Connections >
Wireless Network Connection menu in Windows (or click the icon
in
the taskbar), and click View Wireless Connections.

Figure D - 23
Wireless Network
Control Panels
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PC Camera Module



There PC Camera module uses the BisonCap application to capture video files.

Taking Still Pictures

PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install Camera Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the
desktop, or from the BisonCam item in the Start > Programs/All Programs menu.

Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.
Double-click the camera
icon. Click Take a new
picture in the Camera
Tasks box.
.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows.
1.

Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then doubleclick the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer device menu.
5. Make sure the Mic Volume/Front Mic (check box) is checked, then click OK.
6. Select either the Mic Volume or Front Mic and boost the volume in the Recording section (in the Recording
Control menu) as high as it will go.
7. Close the Recording Control window, and then click OK.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio Input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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BisonCap
BisonCap is a video viewers for general purpose video viewing and testing, and for
capturing video files to .avi format.
1.

2.
3.

Run the BisonCap application from the Start > Programs/All Programs > BisonCam menu (it is recommended that you set the capture file before the capture
process - see Set Capture File below).
Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup” on page D - 36) and select Start Capture.
Click OK (the file location will be displayed in the pop-up box) to start capturing the
video, and press Esc to stop the capture (you can view the file using the Windows
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the File
menu, and set the file name and location before capture (this will help avoid accidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page D - 38 in
order to save file space, and help prevent system problems.


Pre-Allocating File
Space
You may pre-allocate
the file size (File > Allocate File Space) for the
capture file in the
BisonCap program.
Pre-allocating space on
the hard disk can improve the capture quality (particularly of large
capture files), by reducing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.
See also “Reducing
Video File Size” on
page D - 38.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk space for each file. After
recording video, check the video file size (right-click the file and select Properties) and the remaining free space
on your hard disk (go to My Computer, right-click the hard disk, and select Properties) If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash drive.

Note that the Windows XP system requires a minimum of 1.5GB of free space on the C: drive system partition.
In order to prevent system problems it is recommended that you save the captured video file to a location other
than the C: drive (see “Set Capture File” on page D - 37), limit the file size of the captured video (see “PreAllocating File Space” on page D - 37) or reduce video resolution (see below).
To Reduce Video Resolution Output Size:
1.
2.
3.

Run the BisonCap program.
Go to Options and scroll down to select Video Capture Pin....
Click the Output Size drop box and select a lower resolution size in order to reduce the captured file size.
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.
1.
2.
3.

Run the BisonCap program.
Go to Options and scroll down to select Video Capture Filter....
Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure D - 24
Video Capture Filter
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Zoom
The BisonCap program allows you to zoom the camera in and out.

Figure D - 25

1. Run the BisonCap program.
2. Go to Zoom and select Zoom Out/Zoom In.
3. Go to Options and scroll down to select Setting (Use the slider to adjust the zoom
level, and click OK to save the setting).

Zoom/Setting


Snapshot Folder
The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

D

If you accidentally delete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to capture the files.

Taking Still Pictures
The BisonCap program allows you to take still pictures.
1. Run the BisonCap program.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder
desktop.
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Touch Screen Module
If you have included a Touch Screen module in your purchase option, you should obtain a stylus pen to interact with the computer in the same way you would use a
mouse (use a stylus pen to tap/double-tap on-screen buttons etc.). Calibrate the touch
screen before using your stylus pen. Make sure you install the driver as indicated below.

Touch Screen Utility Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/
DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install TouchScreen Utility > Yes.
4. Click Install.
5. Click OK to restart the computer.


Touch Screen Input
Device
Do not use any sharp or
pointed objects as your
input device e.g. the end
of a pen or pencil. You
should preferably only
use a stylus pen (PDA
type) as your input device.
Be very careful not to
press too hard with the
stylus pen when using it
as the input device.
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Calibrating the Touch Screen
1. Click Start, and click Programs/All Programs and point to Touch Utilities (folder),
and then click Touch Configuration program (or double-click the desktop icon

).
2. Click Calibration (button).

Figure D - 26
Touch Screen
Configuration
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3.

Click to choose the number of points in Calibration Precision, and then click
Calibrate (button).

Figure D - 27
Calibration Precision

4.

Use the stylus pen to touch the center of the cross sign until the OK sign appears in
the center of the cross.



Figure D - 28
Touch On Cross

Calibration Points
For maximum accuracy, make sure that you use the stylus
pen to touch the CENTER of the blinking target symbol
when calibrating the touch screen.
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5. When the Test Drawing appears, write on the screen to test the calibration (press
the spacebar to clear any drawing, or Esc to exit).

Figure D - 29
Test Drawing

6. Click Close to exit Calibration.
7. Click Touch Settings (button) to adjust any touch setting (mouse) options.

Figure D - 30
Touch Settings

D
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